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il L C XMLConfig »V—I)VEMRORHL 9, ZD/NTA—%—I3,
WebSphere Application Server Standard Edition /N—33 > 35x ™67 w7
TJL—RTBHEECHETHETT,

-nameServiceHost -nameServicePort
ZDINTA—H—%IEET SHE. WASPreUpgrade V—ILiZINSDH T
aFI) - )INTA—=%—% XMLConfig V—)VIZEL£T., TNED/NT A—
% —Ii¥. XMLConfig V—ILZE>THEHINDT 74 FDRA M ER
—"EFEFT—N—F1 RT5DITHFEHLET,
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-traceString -traceFile
IBM B —EZHEMENEHT S ML — A ERENET S04 T aF
e T A—=H—TF, TRTO L —ERENET 511,
"x=all=enabled” (BIFIfFZ &) Dtrace_spec ZHEL T Z I,

mES2

WASPreUpgrade V —JUi&, FEITHDOAT—F AZEMICEZRLET, £k, THIT
Lz O F 2 TERO Yy & backup T4 L7 U —ITHEELET.
WASPreUpgrade.log 7 7 T ILOANFIZ., TF AL « TF 4 ¥ —THRDHZENTEE
—a—o

WASPostUpgrade 2<% R

WASPostUpgrade.sh (F7z1% WASPostUpgrade.bat) A7 U 7' K3, LAEION— 3 >
F7213U Y —ZM5 Version 5.1 Application Server - Express [ZHERRE T 7'V 7r—3
I EXATL—2ad B0, X4 L—ar - V—ILTT,

AR T7A4I)E, A A R—=)b - Jb—bK®D AppServer/bin T4 L7 hU—IiZ
HDET,

WASPostUpgrade *V—)lid, X1 7L —2a > INtIXRTOT7 U r—ar

Z, N—=Ya3> 51 A4 >AL—=)L® AppServer/installedApps 7« L' 7 b1 —IZA1
SAR=IVLET, TDOY—ILTIE. WASPreUpgrade Y —IVOMERR L 7Z/Nw 77y
T T4 L N HBT TV r—ar bt A N—)LanEd,
WASPreUpgrade Y —)Ui&. BARTDO/N—2 3 > F721EU U —AD installedApps B
KOO T 4 L M) =7 U r—2a>&2IE—-LET,

(34

WASPostUpgrade backupDirectory
[-serverName server_name]
[-webModuleAdditionalClasspath classpath]
[-documentRootLimit number]
[-substitute "keyl=valuel[;key2=valueZ;[...]1]"]
[-portBlock port_starting number]
[-backupConfig true | false]
[-replacePorts true | false]
[[-traceString trace_spec [-traceFile file name]]

NTGA—H —
RAIDOF ZEIINHETT, LTFOFIEHENTHR—FINTNET,

serverName
F T alDY—=N— A AYALTY, T 74 M serverl TT,

backupDirectory
WEDGIEE T, WASPreUpgrade Y —ILOMRE T B E 7 7 1L &k
WMTBT 4L 7 N —DARTTY . WASPostUpgrade Y —)Uid. HkE 7 7
ANEZDT ALY N —D5HARDET, T4 LT M) —NEEFEL
TWaWEAEIZ, WASPreUpgrade Y —IVOMERR L £77,

W2 & EHY—N—OxA( L —a> T
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-backupConfig
FTalONNTA=F =TT, X1 T L—>a3> V=)V HEREEET
LHHNCEBEFE DR ZE Ny 77 v T 57DIEH L £, 774V M true
T, MRENY 27y T ULET,

-documentRootLimit
F7 T arDINT A—4—"TT, Web-application @ document-root 7 1 —JI
RIns 707 I LMAE—F25T7 7 A IVORERELET., N—Ta >
35x DT v T L —RICHLTOABEHEINET, HELRWVWEEDOT T
+J)V M 300 TY,

-portBlock
FT2alDNTA=F =TT, R—bFZERT2ESITHAT HHBOME
ZfaE L T,

-substitute
XMLConfig Y —I)VIZIEZINDF T a > ORI EHRTT, BEEMHMADHFa
V74 —EROMZEREL XS B : -substitute
"NODE_NAME=admin_node;APP_SERVER=default_server”),

AJ] XML 7—% « 771 Tld, BEMWMZSNDHEF 1T Skey$ ERE
NTWET, LOFIDOFIEETIE. AJ) XML 7 71 )LH D $NODE_NAMES
&9 RT admin_node \ZiEZHLA 541, $APP_SERVERS 139 XT
default_server \CBEZEMWZ 5NET,

BEEA RN I a0 nEENL LA KUY XFO "y EXKBIT
57217, $semiColon$ ZfEA L ET, UNIX 7o v b7+ —ATlL, &
Z R RO RIVEEE $) I L TIZAT—TXXFEBMLUET # -
\$semiColon\$).

ZDINT A—4—IF, Advanced Edition /N—3 > 3.5x MOREIN/-H#
FRICHEHA S NET,

-traceString -traceFile
IBM Y —EZHAMENERT S N — A ERENET 572004 T aF
e INTA=F =TT, TXRTOLL—AEREINET D121,
"x=all=enabled” (5IHfFZE L) Dtrace_spec ZHEL T Z I,

-webModuleAdditionalClasspath
FT2alDNNTA—H—TTF, Web 7—HA7 - 771)L (WAR) T
E—LE<BWEEDT 4 LI M) —%RB3 77 A IVDIZABEOT 7 1)V
HEEELET, JE—925RbDIC. 7OV T4 NAET 7 A%,
Web £ a2 —)VDJEEE (ibm-web-ext.xmi) additionalClassPath J&MEIZIE
MUET. ZONTA—F—F, N—Tar 35x D1 A—INEIAT
L—2a3235LEC0AEHINET,

(mE 24

WASPostUpgrade Y —)Lid, EITHOAT—F AZEHEICEZRLET, £z, &5
WA OF > JEROE Y h&, logs T4 L7 MU —ITHREL FT,
WASPostUpgrade.log 7 7 TIILOWNEIZ., TF AL + TF A ¥ —TRDHIENTEE
-g_o
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RATV—=2avIlBIF38BRORYEY

ZOREWZTIE, XML —>3 VIZBNWTEHEINDEHAITOWTHHL X

I, TR, Wi, A RO - I CTOREREDLI BRI -

VUMMEENET,

N—23Y 35 WEN—=23Y 5Xx NDIRA T L— 3>
RATV—2ar - V—)Vid, PATLHREYA7 L — 3> L. I2EE
tFaF—HETYES TR ED NREE REMEERT S ET, N—
Dary 35x MHEN—Tar s NOBITEZBELET, X1 VL —T 3
>e—=IUiE, N—Ta X 35x ORERRICEDWT, #1H8ld 2EE T2 4 —
TIAX T TV =23 D EERLET., 2720, 77U —a Dk
ENWRKRESBEINZZD, N—23 > 5 TP 7Ur—2anEnkd
ICHERES 2 O 2 IEMEICHIR S 272012, BIFRY —)LET a1 A b -y
—WEFHALT, XA L—2a FEsH07 T r—2a & EEICT A
BLOWIHET 23 HZ T TTLZEI N,

XA L —3a >IN/ Enterprise Bean 2B 23/ EHRIC DN T,

WASPostUpgrade.log 7 7 T ILZEDHT L TL7ZEW, I2EE YO/ 537 -
ETINTIE, 77— a P ERERBLYT TOA T 5 HEICONTOY
—FFIFr—DHEEINTVWET, N—=2a3> 35x DT SUr—ar
W7 —F 77 F v —INHE725 DT, WASPostUpgrade Y —)WIZ7 U r—
a EEERLET, REE 77U —2a iZBnWTA( L —2ar&
NH5TRTD Web )YV —A& Enterprise Bean DMERINE T, £/, N
—23> 35x A A=V DITXRTDILIY—TIA X - 7TV r—3
>N, WUARIT REE 77U —23a iRy 7a3N, ACY—N—iZF
A E =¥ g =S

WASPostUpgrade Y —)Uid, T2 —T7 514X« 77U r—3 a AR
FNTWREWL Web UV —2A %, Y—N—DLA4HZELT 7 )L bD J2EE
7TV —2a iRy T LET, ZOYV—ILiE. Web 77U —a >
% J2EE WAR 77y A VIZX w7 LET, ZDYV—)T I2EE EAR 7 71
NWNDU Y —AEREL, ThEN—T3a> 5 ORI 7o1 L9,

V3.5.x MHEN—=23 2 5x NDRA =23V ICBATEYyEV I DM
* datasources.xml

N—3 > 35x O datasources.xml 7y fI)VEFHL T, 7—% -V
—AMERDBREZBMTEET, N—2a > 35x T TOT 7 1)U
properties 74 L7 hU —IZREINTNET, YA VL —a> -V
V3. 77V TaNT 4 —ET—F - —ABXIW IDBC K
AN—DOHRIZY—2 352 & T, BEAFOD datasources.xml 7 7 1)L %
X1 J7L—>arlLEd,
« IVH—TSAX TV =3y

JN—3a > 3.5x @D enterprise-application T U —idA4 7T 3 > TY,
O RM)—=id, EFa VT —BRIHLTH TPV FOREEE
EOTHRRT D720IT, mBKISEHETNET, enterprise-application D
Enterprise Bean & web-application O/ 1%. XML 7 7 1 )L OO E 5
WHHHINTHIT hU—ZELTWET, % enterprise-application 13,
FUARIZERD 12EE 77U —2 3 2 Z2ERT 570U ENET,
Enterprise Bean 30X web-application O T > k1) —{X. Enterprise Bean
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BEY Web 77U —2 a3 OEHEANDORA >y —L L THASNE
o THIT. NS5O MY —DFHMIE J2EE 7 7Y r—3 3 > Z2{ERR
THDITEHEINET,

Enterprise Bean @O 7 7 A )L DA, JAR-file DEFKIX. J2EE 7 7V 7 —
arEBTOA L0, REE YU —a VITBMLZD T 57
D JAR 77 A IR 5720 I3 E9 . Web-application O
document-root L. kU —{X, Web-application W TEHAZN5HU Y —X
(HTML, JSP R—272 &) ZMRIET 2O SNET. INs07 7
AIVZ REE 77U —2a >ND WAR 77 VIZaAE—SNET.
Web-application @ classpath >~ —I&, I2EE 77U —a >ND
WAR 77 A)VIZAE—EN2H—T L v bBXD JAR 7 7 )V &Hih
THLOIHEHEINET,

I H=TIAX-TTUr—arid, N—=2a3 > 35x NH6DORAYT
L—2a > oOMBETHERENET., IN5IE 2EE 1.2 BT >4 —7
FAX T TV r—=a>ELUTERSN, =T Ly k22 LIS
KOVISP 1.1 LNIVDEZ 2=V EEFAHET. JIUTKD. ROEEN
IR EMENRAE S N, RBID/N— 3 > D WebSphere Application Server &
DM EEH N AIREIC/R D £ 9

J2EE ¥ U771 —

N—=23 35x OEFal)F—fFETINNE, Z2F—T51 X7
TV r—2aBIUOAY Y R« T —TOZITEOINWTNWET, T
=T IFAX T TV r—a>EAYy R J)—7000ZFE0,
WebSphere Application Server DFFA[IZ/20 £9, J2EE OfEARIZIL, &
CHEDLSFHFAET VARG ENTNET,

JN—a > 3.5x @O WebSphere Application Server #Fr]ET )LV & /N— 3
> 5 ODEEIN—ZADOF BT IVICEMT 5720, X1 7L —ar Y
—)L1Z. WebSphere Application Server DFFRINSZDT TUr—a >
TOHLWEENCHTS 1 % 1 O v ESTZ2ERLET. LMo
T, V35X DELHY—TIA X - 7TV T—2a BRUOEAY v
RN —=Tl, XML —ar - V—)liIN—a> 5 O%H
EERLET, INHlE. REE 77U —2aoFr7af Ak -5
A AT —IZEENTVET, TNTNOREI TN S HHRIT.
EE 77U —2a>ONA 2T 4 2 TIHHHFIT—TIIZEENT
WET,

J2EE OAEAICIE, HENCE DO SHFIETINEETNTNET,
WebSphere Application Server (£, UV —AIZ7 VAT 520D —HEHD
el EER T 5% E| Z R L £ 9. Enterprise Bean A/ v ROIEUHIL
DG, FED Bean DAYV RIZT V VAT 570D L, AV v R
Frlick o THRESNET, ZDAY v RiFrlid, Bean JAR 77 1)V D
FTTOAAALE - T4 A7V THZ—HND 1 DL EOZENEEEM T 51
EC N

Web UV —ZANDY 72 ADHEIL. Web URL IV Z7E2AL. £D
URI @ HTTP AV v RZFEOH AN, J2EE {LE£D Web UV —
Al ZraryBrOtFa) T —HKENSETHREINTVE
T, BFaUT 4 —HKE Web UV —Z - LT3 id Web 77
Jr—a>® WAR 77 (DT TOA AN « T4 AU TH—I
HDET,
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« JSP LRI
N—>a> 513, ISP 10 & 11 AT b%E, ISP 1.2 DA T
T FELTEITLET, N—=Ya3 > 5 NYR—KT5LX)LIT ISP
1.2 729,

s Y—TJlLyb-UFGALLIOH—
N—2a 513 DEiON—=23 >0 —TLy k- UYL LY —%
YR—bFLERA, AT L —2al - V—JlE INHD0OF TP r b
AL ET,

+ V35X M5 V5.x [CRATL—2a30F3LE0H—TLy b Nyl
—JRADEE
N—3 > 3.5x O T SimpleFileServlet —7 L v MVERINT
WBEE, 2O —JLy MIXA VL —TaranEzth, 1L —
a2 —)id. Web €EZa—J) + 77 1) ibm-web-ext.xmi N®D
FileServingEnabled J&:% true IZTREL X7,

IN— 3> 3.5 ORERRT InvokerServlet ' —7 L v hERINTND
B, ZOY—TLy MIXA L —raInFth, X1 L —3
> —)Uid, Web € 2—)b - 771 )l ibm-web-ext.xml D
ServeServletsByClassnameEnabled f&:7Z true IZEXEL £,

IN—3 > 3.5x O T DefaultErrorReporter H— 7 L v MINEZRE I 11
TWAHEE, ZOY—T7L v Md Web TP a—)b - 77 1)L web.xml
XA —2a EdINExd, XA 7L —2a>Tld VIAAZRET
HDITH LWy =R INET,

« FSIURKR—=F
N—=23> 35x DY —TLy b - Z2P2DF 74Nk bT 2 AR—
I+ &1 713, Open Servlet Engine (OSE) T9, N—a > 5 Tid
OSE h T2 AR— I R—bFINa<okizd, X1 —3
>ew—=iE, AUR—FEIDETE/EALT, NS5O T AR
Z HTTP h T 2 AR—KIYy 7 LET, R— KT &I VirtualHost T
AU ADITY b —ZFETEMT S2LENHD LT,

BERT—9DFEHTAI V-3

CDHATHHTHEDIC, 1A =)V U4 F—=RZHEHAL T, £ TH
T, EHMERZYA 7L —23>TEEd, XML —2ae2FHTHO8EE
3. A A= Ty = ROA T L —al s XNV TIYA T L —a -
Frvl Ry AZEIRLBZNTLZI 0,

DIRGTD/IN—3 2 > D WebSphere Application Server ZffifH L TWAHAEIL, AT
LEBEMN., 7TV r—2a 0P —N—DIXTIFRhB/EE. BEICEOETH
FEEL TWAHHREERH D E T, ZOXIRFEEHRAREDOR ER/NROIELT
RATL—2a I8 HETH2LENHD X,

FEHTOERBHYA L —aid, XA Lb—al - V—)LZEDERLIEOH
L. TR LT 7 ANV EHEETAHIETHEITTEET . EROMK Y
TANWEFERTHOIZIE, W<ONOEBHNHDET., EOXIREHTH-T
H, —EIZ 1 DOWR 7y ANV EIA L —2a 5T ET, ROWEKRT 71
WCHEDRIC, 77U —2a DB T A N2 2 EMTEET,
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RATV—a - V=)VEERT ST, Vix OV U —AIERERIZZI-L T,
LHTDN—=2 a3 VCHEMAT 20 EOH HEBIEZHERL T ZS W, BEiON— 3
COBIEEZBEHTAIET, XML —2a IEHT ST 7 1 IVITHEIENEH
SINHGEENHDET, BIEZEHTZIET, MlkeY 7 U —2 a3 > ZrlEeR
BROBRBIBIIIATL =232 F2HTENTEET,

FEICEDBYA VL —2a>TEH A ARV - U = RPRET 25822
AL —=2a kDI SIEENBRIA 7L —2a P HENHBEINTHET,
IBM &, V3.5.x £ V5.0x ODIEEDMA S WebSphere Application Server -
Express HMICEHEERZYA L —2 329500, —@#HOIATL—23a > -
V=V ERELTWET, Y17 —a > 0efia7ot 2,
WASPreUpgrade X1 7 L—a > « WV —)L&MH L THRIEOHK ENERT 71 )
ENv 27y 7l, BEiOUY—2%7 >4 > A=)V, B#IRA VL — 3
YA T a EBRLBNWTN=Yar 5 B2 A ML L7zt,
WASPostUpgrade X1 27 L —>a > - W—)L&FHL TUROY U —ADHKZE
TLTHENIHDTT,

¥spk 7~ —4 % WebSphere Application Server OFEA /) — R /L —2a>§5%
HEIZDOWTIE, UFORA T L —2a - 2 FUFONTNNERRL TSES
t/\o

« [TV35x 75 V5.1 ADXA 7 L—2 3] |

e 4 R=DD V35x MEUE—K V5.1 XA ADIXA 7L —a ]|

e [7R=>D Tv5.0x 25 V5.1 ADIXA T L —23 ] |

e (7TR=D TVv5.0x DEUE—K V5.1 X >ADXA T L — 3] |

s 9R=2D THR—FINTWERNWARL—FT 4 2T - AT IDNEDIA T L

V3.5.x IS V5.1 ADRAL I L —3Y»

ATV —ar - V—)VEMHEHL T, )N\—a > 3.5 @ WebSphere Application
Server N5/N—33 > 5.1 @O WebSphere Application Server - Express (AR T —
YEXA L —2a TEET,

X, WebSphere Application Server V5.1 DAV L— 3> «V—)b
WASPreUpgrade 35 U8 WASPostUpgrade Zf L T, AL ¥ > ET V35 5
V5.1 7w 77 L —RLET, BT >D V3.5 ERZH DT > D WebSphere
Application Server - Express V5.1 XA 7L —2a > 952 FUFDEHEIL.
[R=2® TV3s5x MBEUE—F V51 X3 > ADYA 7L — 3] | THBlanT
WOLREFIEEZMHERAL T ZE W,

ZOMEY T, V51 DAL —2ar V=)L TII 7L — 3>
IO HIEITOWTHHL ET,
* WebSphere Application Server Single Server Edition /N—2"3 > 3.5

WASPreUpgrade Y —)Vi&. BEED V3.5 Ok % . migration-specific-backup 7 A L
7 N —IZfRE U E T, WASPostUpgrade Y —I)Uid, ZDF 4 L7 MU —ZfHL
T, HOWEERROBREZH LW V5.1 BREIGEML £,

COERDAT T
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1. V5.1 D CD-ROM 2 AFT 5,
Z® CD IZid. migration/bin EWSFT 4 L7 RU—MNHVET, TOFT 4 L
7 R —IZid, V51 &A1 2 A =)L L72WT WASPreUpgrade Y — )L ZFEIT7
HIDIHHATE DRRBERENEENTNET,

2. V5.1 #E CD-ROM @ /migration/bin T4 L7 kU —IZd& % WASPreUpgrade
A7 VT NEFHAL T, BEOHBRERET 5,
%% migration-specific-backup 74 L7 U —IZREL £9

WASPreUpgrade /usr/tmp/migration-specific-backup /usr/websphere/appserver yourNodeName

WL DBIEE DY — N—AEE L TW\W5 Z & 2R L £9. WASPreUpgrade
Y —)WE, R EBEEICERT S 4T, migration-specific-backup 7+ L7
c)—onZ - 77 A)VZicék L £, ASCIH X007 - 7 7 A )L DRI,
WASPreUpgrade THAZ D, AMDY AL « A > TREENTVHET,

WASPreUpgrade Y —)U1d. BEFD V3.5x BRICHEET DU TFTOT 4 LI N —
KEENDIRTDT 7 AINE, NI Ty T T4 L7 M) —ITRELET,
N— 3 35x DFE

* bin

* classes

* hosts

* properties

* servlets

WASPreUpgrade Y —J)U1d. V3.5x @ /bin T4 L7 hU—m5, BRINZT
7AINWERELET., £z, V3.5x OURD MU —n5BEFED Application
Server DRk E L7 A7 — K~ L EF ., WASPreUpgrade *V—J)Lid. XMLConfig %
FENH LT, BEFED V3.5 OUKRY M —% migration-specific-backup 7 «
L2 b —® websphere backup.xml 77 1 JLICTY AR — KL ET,

WASPreUpgrade Y —)VDFETHICT T —DNFET HHEG5, TV AFR—h - A5
W T ERIEFICETTH2DI121E, V3.5 OA1 > A b—)IVITEIEZ#EH T 208N
HOGEEMBHOET, ZUTHAEENED D D EFOEEICDNTIE. IBM O
R—h « R=TPZZML TLZE W, InfoCenter 705 ZDFIHRZFRT DI,
IBM U R—hk - R=2JICU 2L TW5 [HR—F] 2270w 7L TFEW,
3. WebSphere Application Server - Express /N—a > 5.1 #EA > A N—)Ld
éo
ATV —2al AT aNERINTHRRLZNWTIZEI N,
WASPostUpgrade DMK T T 57202, 2 DDOT 7 1)V T V5 OR— N%E
ERELET,
* serverindex.xml 7 7 JLTI&. serverl {Zk}d"% BOOTSTRAP_ADDRESS 7R—
NDEID Y TEZRET S,
PARTDIN—2 3 > D BOOTSTRAP_ADDRESS 7R— k7% 900 O#H&I1E, <A1
JL—a2I2&o>T 7809 12Xy 7INET, UUFIDN—Ta > D
BOOTSTRAP_ADDRESS "— k2% 900 TldaWi&Eld, Y1 VL —2a i
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&> T. Advanced Edition ¥ 27 L —2a > T® serverl 1. £7/ziZ
Advanced Single Server Edition X1 7 L —2 3 > TOHEBEOHT—/N—4IZ, <
v TEINET,

« server.xml 77 1)L TI&, HTTP Transport "— FDEID Y TEHRET 2,

WASPostUpgrade DLETIL. PLRTD/N— 3 > @D HTTP Transport 71— b
W, N—23 > 5 O server.xml 77 AIVITEIMSNET, DD, serverl
i EENRVNS E, BRION—2a > OF 730 k- H—/N— 5
@, EHT 2 HTTP Transport A — FEID LY TRZTENTNET,

4. V51 A1 A=)V @D)b—hk T4 L7 N —O AppServer/bin T4 L7 KU —
IZd % WASPostUpgrade Y — )L &M H L T, LARTOREKRZH LINT > A b—)b
WAL —2a>d5b,

WASPostUpgrade *— )L, WASPreUpgrade Y —ILIZ X > TIER S /2 V3.5.x
ORERRIERZE, V5.1 OA A R—)UIZXA 7L —>a > LET, V51 85k
REE 7075327« EF)VTHERL. V35x IZERLZND T, V3.5x O
Bz V5.1 A A S =)VITEMT 2121, RIEREENHLETT,

V5.1 KT T > AIVEEROA Y =)L - 7TV —2a >RHBH5DT,
WASPostUpgrade V' —)Lid, B> 7IVELIERI Y =) - 7T U r—ar
DORATL—aa{tThwER A,

WASPostUpgrade *V—)Lid. 77 O1 I3 %% Enterprise Bean |Z[EH OFFEHlE
7. WASPostUpgrade.log 7 7 1 )LIZ. sidklL £,

5. BEION—=2 3 > OEHT—N—=0KE L THWLHHEIE. N—2a> 5 O/ —
RZBET SETiFIET %,

6. XA 2L — a>fIT WebSphere Application Server D#pkZ1T7> T, ¥ 7L
—2ar -V IOMRERELET, X1 7L —a > O@PTHKRY Y E>
JEMEHALT, XA 7L —2aORERETLHIEDTEET, FEVIIC
. XML —ary V=R F TPz hNERA T L —a T i hikE,
BRAENHERIEHIC DWW T OFEM/RFHBHENG D £7,

V3.5.x MOBUE—PN V5.1 @ADL I V—3Y

ATV —2ar - V—=)VEeALT, 2 DO UMOFHIYA L —2alz
FITTEET,

MK 1. WebSphere Application Server - Express DX 7/ L —a > «V—)b
WASPreUpgrade 38 WASPostUpgrade Zff L T, FAIC ¥ > LT V35 o
V5.1 7y 7L —RLET,

LinL., 53 >D V35 BkzEpNo~ >® V5l I 7L —a Lt
NFRSBNSFUANHDET, ZOXD BT FUAD 1 DELTIE FHiLny
DUCERHTD V51 BEEEA A R=ILL, —HFTHOY I ITHDEEFED V35

WREXA 7L —2a T 20RERHLEDREETT,

ZOREY TR V5l oA T L —ar - Y—I)LEFEHLTII L —2 3>
IO HEITOWTHHLET,

* WebSphere Application Server Single Server Edition /N—3"3 > 3.5
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WASPreUpgrade Y —)Ui&. BEfFD V3.5 OWERRZ. migration-specific-backup T A L
7 U —IZRE L E 9. WASPostUpgrade Y —J)Uid, ZOFT 4 L7 M —ZfHL
T HWHEROBREZH LW V5.1 BREIEML 7.

ZDEED ATy

1.

V5.1 #5D CD-ROM = AFT 5,

Z® CD IZiZ. migration/bin EWSF 4 L7 NU—DNHDET, ZDFT 1 L
7 FU—IZid, V5.1 A A R—)LL72WT WASPreUpgrade Y — )L 51T
LI TEDRRBRENS ENTNET,

V5.1 &k CD-ROM @ /migration/bin 5+ L' 27 bU—1Z&% % WASPreUpgrade
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Jar s EN—=Tar 4 ORTHEINTWSAEE, ZHIEREETEHSDE
HTh, N—Ya3 2 4 7Oz MNIN—=a> 5 Jovoy MG T
L =23 A THDLIENBET, WolzAXRA T L —2 3 VEATRDE
SCM Y AT LIMEN—T 3y 4 IZR->TO—RINAHT &I TEEE A,
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IBM WebSphere Studio Site Developer @ Web 7Oz b
DIEE

IBM WebSphere Studio Site Developer /N—"3 > 5 @ Web 7O 7 kDN
iEld. LARTD IBM WebSphere Studio Site Developer /N—2" 3 > 4.0.x OEH &E1F
RI20ET, TOEWE 2EE 1.2 & J2EE 1.3 OEWVERZEFRRS, LAY —
DN TETDENVIZEDEHDTT,

N—23 > 4 TlE, Web 7027 MET 74V T &) Web 7O b T
HoT. [FES—%— (Navigator)] Ea2—IZ TY—R (source)] 7+ I)¥—BX
N TwebApplication] 7 4 )V ¥ —ZFDOB TERINELZ, N—Pa> 5T
2. B Web 707 h&EEKRTSHE, [V—2R (source)] 7+ )% — Tl
72< TJava Y —X (Java Source)l 7+ )% —IZ. TwebApplication] 7+ )%
—Tl372< TWeb 327> (Web Content)] 7 4 )L¥ —ICFERINET,

LML, N—=2a> 4 ® Web 7Oz h%& SCM YR MY —IZHELTHS
N—>a>r 5ico—Rd5%5&, V=X (source)l 74 )LF—&
l'webApplication] 7 4 )L ¥ —ZFOHWEEOEEEZRINET., E5 5O
HN—2a> 5 TIELKEINRENZET,

7O o eI Os sy oyt

N—3 > 5 Tid, B Web YO0/ AT THRLIEN IO 7 FHIERT
HZEINTEET,

Y Web 7’027 M. HIML. Java AV U T~ £ A=, TFANED
B —2ADHEGH, BN T oV EEGATEEA, B Web 7027 b
13PEKD HTTP Web ¥ —/N— ETETIN, Y—EZXZZITTNT Web 77U
—Ta Y= N—FpEELLEFA,

@JE@ Web 702z 7 MIFEHY Y —ZADEFNT, =T L vk, ISP, 71 )L¥

. BEMT SN AY T DX S EM J2EE VY —AEEAET, B
Web Tavxl bEERTSHE. S8R0 s b UV —A0ky bEHL
THEZROD SN XD, WAT—R - ZA¥ )+ >—hE ISP YT - F4T 5
J—Z /AL Z &ﬁ‘f%i@—o B Web 702”7 MEIWD®H Enterprise
Application 7O =7 MIHAAEN TV T, Web Application Servers b TDHHE
franxd,

HTML & JSP DihE=S

e N—2a > 4.0x TIL, Page Designer 78 HTML 7 71 )& ISP 7 71 )L %[d]
PRI L TWE L7z, BIAE, ISP #27% HTML 7 7 1)V CTHAT 52 &N
TEELz, SRBRIZZOEODBRMEANTERLSABRDET, DEDZIDUY—XT
&, ISP 77 1)bE HTML 7 7 A IIVIKBIENET DT, ISP ¥/ % HTML
Ty AINICEDD I EMTERLKRDET,

o PEROXHITIL, FWEELSD ISP 77 AN DOIL>I— NICEEEZEZ LT, 20D
U —=AXDHEION=23 2T ISP 77 AMIVDBETH, 7 7 1 IVNDIEE
I>a—RERETSH2DIZ. HIML T>d—R - )b—)VMEHINTHhEL
2o DFED, AF - HZTOACTY - A TEEPRBEINEL
(<META http-equiv="Content-Type" content="text/html; charset=UTF-8">),
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GEION—2 3 > TR, TNNEEIN, ISP T3 — R - )b—)Z2#HL T,

JSP 77 A IIVNOIREL > A— RMRESINDHEIDITABRDE L, DXD. ISP
T7ANDR=2 « T4 LT T4 THRRINET

(<%@page contentType="text/html;charset=UTF-8"%>), HTML 7 7 1)L D

X, T2 a—RARIBERON—2a3 2 EE2DDHDER A

Y7 bUITHERERE (SCM) Y RTAZERALAETADC I MDAV

—-ay

CVS % /=(3 Rational ClearCase Z#{#ERL/A=7A> x4 bD7A
AP
= ANR—A%Z/)N—3 > 40x /5 IBM WebSphere Studio Site Developer /\
—Yar 5 AB#HTLEGIE. COFEOEREB#BOLET., T Oor oy
ke EILR - RADBERZED, ITRTOBEREYA /L —2a>T52DDM—
DHIETT,

1.

N T Ty TDEDIZ, IRNTON—Ya> 4 JOPx7 h& SCM UKD b
U—IZREL T, XRIZ, REPOIXRTOLEEZIIv K (JU—R) T%,

I —H—7/3 IBM WebSphere Studio Site Developer /N\—3 > 4 BIUPN—
ar 5 TE¥ETHIEEZ2EDEA. EEBREBETHON—a> 5 75
CF (ARU—L) ITRET S, ZOTTFIF. N—Tar 5 TEETIEA
WAL £,

N—>ar 5z Ab=)T5,

IBM WebSphere Studio Site Developer /N—>3 > 4 27 10—XL., IBM
WebSphere Studio Site Developer /N\—> 3 > 5 ZBBL £,

EVb: N—=232 4 TR DU AR=Z T4 L7 M=, T4V 1
T AA=II T4 LT RM)—ICA>DTWELZ, N—2a> 5 Tld, Z
DT 74 83, My Documents] 74 L7 hU—HN®D, D=0 XAR—2Z]
EMENDT ALY MU —IZEDVDE L, EEERETH O —2aad—
N=FA4 RLEWGER, V=X FZBEHTHLEEIT,. AV RO -data
FTa EHHALET,

iE: -data ZHEAL THMEON—Ta3 > 4 J—OAR—=A%ZHRA > FLBRNT
LIV, ZOF T alid, ¥R—hENTWRWIEOY A VL — 3
> 77O —FTY GELLIZ B6 R=CD TEEFEON—Ta > 40x T
AR ZBALETOC ) FOXI I —2 o] FBRLC< 2
[/3)0

4> K%Y (Windows)l > %% (Preferences)] > [T —o RV F

(Workbench)l > TEJL K&V Y —XZEERICBEHTREIT (Perform build

automatically on resource modification)] #{ffRn[I2d % (&% DHEIET

Oz 20— RIHEZRCENR - T2 EIIBNEIITTH2D),

CVS A: AL L /=nwIRToO7Oy s % SCM URY ~J—75 IBM

WebSphere Studio Site Developer /N\—a > 5 iIC0— R %,

ClearCase DiFa: VU—7/N\N—Ta 5 J—UAR—AZFHLT. &7

OYzZ McO—R35%x8,. [Z774) (File)l > T4 >2R— bk (Import)] >
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FR7ED WebSphere Studio 4.x ClearCase 7O 1Y hET—U AR—2R
~ (Existing WebSphere Studio 4.x ClearCase Project into Workspace).
ZERT 5,

7. T4 > KD (Windows)l > %% (Preferences)] > 7 —O N> F
(Workbench)l > TEJL K& Y —RZEBERICHEHTREIT (Perform build
automatically on resource modification)] 23 2 HLDREEEILT 5.

8. Web 7O/ MZBWTT)L - EJV R ERLSE, TV—2X (source)l 7
+ I —%% TYV—2R (source)l "5 [Java ¥ —R (Java Source)l ~. <
L T TwebApplication] 7 )L % —/n5 TWeb 325> (Web Content)l
WKEET S, ZTOXIICLBNnE, HWT 3 )Y —RBEENRFINT Web 70
Pl MERICBEN RINAELSADET,

9. ZIVEHEILR (IZFAP x4k (Project)] > TTRTHEIL K (Rebuild all)] )
EEITUT, fESN7 027 haFHEN—a> 5 AN —LDURY
N —ICHFETS (INBDUY—AZBTON—Ya 4 ANU—LER
BLARNTSZEZ N,

EF: Insoyoros MR BIER. N—Ya > 5 TOPxl Mo TH
0. IBM WebSphere Studio Site Developer /N—3" 3 > 4.0x TIIffiH T
FH Ao

AT —a s EDOEERIE:

+ IBM WebSphere Studio Site Developer /N\—<"3 > 4.0 T, 7Oz hND
T7AIWVENAFU—+ T4 —< v FT CVS NIZREINTWELZ, N1
U—»+ T7x—xv ;TlE 77 1IIVNOER/LATIE DT Ty b7+ — LT
HT 2720 DEMENTHIT, UNIX®/Linux 7T b7+ —LARETIIER# T
FtA, BAET Ty M7+ —LRE BIZIE. DOS/Windows 3K TX UNIX/Linux
T T H—L) TEELTWDLERIEF. V=X - T7 M IVIZTFA DT —
2 %13 T ( TF—A (Team)l > [CVS ASCINAFU— - FONT 4 —DEE
(Change ASCIl/Binary Property)l Z{fif). CVS IZHRETAHIENTEXE
ER

« CVS URTP KU —MEDN—2a3> 4 Web 7027 hTlE, T4 RD
(Window)! > TE%%E (Preferences)] > [F—LA (Team)] > [CVS] > TEF 1 L
2 MU —DHELY (Prune empty directories)] Di%iE & F I AnICT DTN
HOVET (T 74 N TIRHMEAEE), FEARMICETIC, EDOY—R - T4 )Y
—%ZFD Web YO b (Web il MyHomePage 72&) 20— R34 5&, Fx
A R TOL DRI I =N ET,

The project was not built since it is involved in a cycle or has classpath problems.
Missing required source folder: /MyHomePageExample403/source.

¢ ClearCase VRY M —IZREIN, TIMH0—REINZ Web 7O 7 +D
BE, 77 ANV EFzv I T7TORLIEWE, I ¥—THLSZEIZTEEE
o 77 ANEFyv 7T RNLBNEEE, TCOE2—DFEMERICTS
— (error activating this view)] (Page Designer @172 T® NULL "1 > %
—faNy ENWDTT—MREINET, xml TT4 Y —2EHL T webxml 771
I ZERET 556, webxml, ibm-web-bnd.xmi, XX ibm.web-extxmi & F T v
7T RTHBBENDDET, (RAZRTIS, INH6DT 7 A IVNHAHAID &
HATHO, Fzo V7T NTHLERNDDERINTVETN, RBILNET
9o )
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OVl MMERIKERBRERF> TWUE, N—Ya3 > 5 BEILR - Z5—%
WwMELET. Y42 KD (Window)l > [ERE (Preferences)| > [Javal >
ra>/84 >— (Compiler)] &99H, TEJLR /XX (Build Path)] ¥ 7%
BEBIRLT, TEWR - 1RR-I5—TEIRDITHEHIY (Abort building on
build path errors)] F v 7 - Ry 7 A& @R @ERTEET,

e vem_meta (E7213 .cc_meta) 7 7 A IVIIN—T a3 > 5 TEEHI NN ON—2
a2 5 TIEHRDITH LW project 77 AIVIMEHINET) OT, HIRTES &K
IRV FELE, N—=TYa> 5 Joyzs MIBELTE. HLWIURI Y — -
TI7320F (AR —L) DMEHINTVWET, ZN5DO7 7 1IUd. 51 &k T
DN—=Ta > 4 TI732F (ARU—L) ITHETT,

EAR 8LV Y—N—iBRDOETPI/INABBOIA I L -3 %D
N

IN—3 > 4 EAR IBM 77U —3 3 JHRRMRE T 7 AV & — N—H#k 7 7 1
INFHERIN A E G ATWE Lz, TNHEN—Tar 5 AL —ar
LTS, N—=Ya> 5 DT 47 —THIBERHDET (LT 4 & —I3Hk/Y
AZRZEH LRSS RABBNICEE LX),
1. TNETNO EAR 7O 7 hZ &Iz, [FEX—#— (Navigator)] Ea1—T
TMETA-INF/application.xml] > T7 U4 —2 3 > %i5E L TH< (Open
with)l > IF7O0/4 AV b T4 RO U TH— - T57 44— (Deployment
Descriptor Editor)] Z4AX T A« RY 2TV w T 5,
a. FA700 T4 RTICAYyE—=URRy 77y TIN5,

The IBM extensions file contains deprecated absolute paths.
This can be auto-corrected and should be saved. This will
remove the paths from the file, and only needs to be done once.
Would you like to autocorrect?

b. TIELY (Yes)l 227U v 7§ 5,
c. RELT, T4 — U1 RUZHL5,

F: RO, REE XMV L —ary -4 —R&fi>T EAR 7OV
I NOADDIZT O ) MEEEYA T L —2 3> THIENTE
£9. IREE XA JL—2a’ -4 —RIZTY VAT H=0I1TIE.
EAR 7OV FZEHARTA Ry T Uw L, R R4 —
3> (Migrate)] > [J2EE ¥4 L —2 3> - U4 ¥ — K (J2EE
Migration Wizard)] Z#RL £7,

2. H—)N—+« )X=AXZTF 17 (Server Perspective)] E1—., [H—/N—kpk
(Server Configuration)] £ a1 —0DZNZENDOHY—N—HRK LI, [H—/)N—
(server)] ZAHNTA Ry > Tr w7 LT TR (Open)l ZiERT 5,

a. FEROBEBGETIEY A 7 OV MERINET,
b. Tl (Yes)l 271w U T 5,
c. MELT, T5445— U142 RUZEMAL5,

TOfthdd SCM ZERALZTO I MDA ITV—2 3>

IBM WebSphere Studio Site Developer @ SCM 7' Z 7 A > &L TW% SCM X
D A X T SY Gl E wiRY: SR OIS A
|WWW.ibm.com/software/ad/studi0appdev/partners/scm.htmlI@N = UANESRL
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TLEEW, N=T 3> 4 TI5T4 ERELTHLETRTD SCM N2 ¥ =3,
ENTND |Ready for IBM WebSphere Studio software|
[www.developer.ibm.com/websphere/ready.html] #REED—H & LT, RO A 7L —
Yare ATy T ON=Par 4 5 SCM URY b —~ORE, URI Y —
MHEN—T3 > 5 ANOO—R) MENTNDI AT LATHHEET 2 Z E2MHRL £
ER

7az O PDIVRAR—PELVS Y R=PICEKBTLI V=23
1. IBM WebSphere Studio Site Developer /N—3 > 40x Tld, 7O =7 h%&
WAR 7 74 )V, EAR 77 1), £/ JAR 77 A IVIZLZY AHR— 1T 3
(774 (File)] > [T& XR— b (Export)] ).
2. IBM WebSphere Studio Site Developer /N\—2"3 > 5 Tld. WAR 7 71 ).
EAR 77 1)V, £7IL JAR 77 )V %EA >R —KrT53 ( [Z74)L (File)
>[4 iR—F (Import)] ).

FEF: 7Oz FOEILR - NABHRBETFINTWARNWD T, ZHUIZERTA
JlL—arTldbbDEd A,

BEON—3y 40X D—OZAR-REFERLETAS I DALV
—-av

ZO7 7TO0—FIZEAMIc LN R— b EINTHE5T. YA L —Ta  idRER

TY, A=Y — A =T —ARE. TNV ITHE. BERMFZELEDHREMN

TRTHEELET, Yooz b4, 7020z b -I—Z - T71)b, BLXYT

OYxZ b Java EJVR « X2 (7 FZNA) BRESNETN. TS0 b

TRTRIESNERE A, 207 TO0—FZ2FHT2DIE, SCM ZHR— KL TWaR

WIATLEHERLTWAHE, 70227 b« EJVR - S2AEROREIAR]

RIzGE, DFED, N—=Ya > 4 Mo IV AR—rLiz7Ooyz s haeA1 hR—h

T2EENEDEBHRMHEET 2HBITR > TSI N, ROFEICKD, BEFEON

—23> 40x ODT—DAR—AEHHTLHIENTEET,

. URZ MU —IZHT2REATOITRTOEEEZII v b (UIU—X) T5,

2. IRTDN—ARYT T4 T%710—ZL. IBM WebSphere Studio Site
Developer /N—> 3> 4 vy "D T 5,

3. workspace_directory DINEZINY 7T v 7§ %, T I T, workspace_directory
i N—=23 2 40x T—VAR=AMA>TNWBET 1 L7 b —DELEH
#TT. TIAINERTIE, N—=T3> 40x T—IAR—=ADYTF 4 L7 K
=i, ZO-ENA A= EINTWET ALY NU—=ERUCTA LY b
J—IZADTWETY, IBM WebSphere Studio Site Developer /N\—3" 3 > 4.0.x
EHELHELZWERIZ. ZONy Ty TRBEIZR0ET, N—Tar 5
IDE MHN—2 3> 40x V=T AR—AZRA > RTBE, TOT—T7 AN
—Z1d. IBM WebSphere Studio Site Developer /N\—" 3 > 4.0.x TR TE
<D ET,

4. IBM WebSphere Studio Site Developer N\—> 3 > 5 21 > A =)L T %,

5. N—23 > 40x T—27 AX—A%ZFFD IBM WebSphere Studio Site Developer
N—=2al 5 2aAX2R - 7O TN BETLHEEG (OXD, AT R
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@ -data A7 a P EMEHLT, XN—Y3 40x V=T AR—Z T4 L7
R =129 22BN A ZIRET 5B E). metadata FHRDT v 77 L —R
DREAICED ET,

6. FHADI—H— A —Tx—A + T5—<v MIEHLTZWNE DD EHE
RIBTOT NS, TOKI 270w rd 5%,

7. BEWRZTIH. FREFT -V AXR—ARNOTOT 7 N4 ERET S
R, TUY—Z (Resource)] /S—AXRT T4 TD [FES—4—
(Navigator)] E2—IZA>TWATXRTOTOT Y h&EIRL T, Ry 77y
T e AZa—m5 TREHFRT (Refresh)] Z#INT S5, ZHTHIE. TXXTO
Ty AININENZTNDAY T—% ERATHE I/ D £T,

8. AL TWAIRTOTO 7 hEMH< L FOBAIOMEZSR),

9. VI ANAERERET S (UL FOBEAIOMEZ S ),

10. ZON—2ar 5 Tld, —HoENY—oNY F—=F =B, FRE £213
EHEINTVWET, TIT—PEENELLERINDEHICTBICE. FA
21U b (Project)] > T RTHEJLE (Rebuild All)l ZZRL TIXRTOD
TOV 7 FEBEIRLTMS, & Java 7OV T &I TRIEDRETT
(Run Validation)] ZZERL £7,

1. I—H— - FU Ty L2 A —HERIIFTEAENDHERINEEL, N—D
a5 DT Ty L UARENHEEB D DFREITHES> TNENFANRNTLZS
t/lo

EAR &L UVY—N—iBROEFI/INNASBOIA I V-3 %D
&%

B5 XR=2® TEAR BELUOH—N—HEKDHX/NABHOY A 7L —2 3 RO
BEITc#HHALEYA VL — 3 S B0 RN 2 THEHEINET.

BIAfES L UHIFREIE
IBM WebSphere Studio Site Developer /N\—a > 5 T )N—2a 2 40 OT—U A
R=AZANTIA T L =23 LEHETHE ROXDRMENFEET D &
MHDET,

JRE_LIB ¥ SANAEHNEN/MEIC/ES

JRE_LIB 77 7 Z/NNAEHK =G0 r—a VIR ELETIZE. UFOATFy T

ZRITLET, [3E (Preferences)| 7 4 > RUZRMICEH & &3, EHIEL N

FIOCHAZBETH>TH, COBRMEEETLTIZE 0,

1. T94>YBFY (Window)l > l%%E (Preferences)l > lJaval > 1 X k=)l
&7 JRE (Installed JREs)| %j®{Rd 5,

2. ZOYART, JRELLIB #%EJT 5T 74D JRE O — a3 >DF v
7Ry 7 AEERT 5,

3. MR&E (Edit)] 2R L. X2 TOKI 227U w27 LT NREDHHE (Edit JRE)]
Y470y - Ry AZHLC 5%,

ZOEERITOAR WS, JRE_LIB OENIELL7/E</ZD, Java 77 1IVITEL D
EJIVR - 25—24A LS EHRRICERLRENENH D T,

— R EREE LT, MOTRXTDY T ANAEBEDEZFRTLIZI W,
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Llgid SCM £H7O2 Y bD IF—A (Team)] A=a—IC I

A7 x4 b (Share Project)] BEFXFhTWS

Eclipse 1.0 & 2.0 ORT, F—L4 « BR—FRKRBICEEINE L, TOP

FEURD M) —EHHAT I FABAETEINE L,

e OV NEARTA - RY Ty L, [F—A (Team)l > 1702
2 DA (Share Project)] 7> a ZzERTHE, TP —RIZLDTA
TJl—ary s 7atZNHA RanEd, TN TTcE, 7o b
HEHEN. [FM (Synchronize)] Ea—MBHEET., FEITIEENED T 71
WIZH RSN ET., Z4UE. Eclipse 1.0 & 2.0 OB TREAEBEROMRE OH AN
BN 5 T,

o WAEEMNRFNE (DOFED, ETHRLEY v 77 L— RFIAEETT S0
2, IRTOMNEEZIIy FLAEGEIE. HAEETREALZNET TY),
Bz TR (Synchronize)] Ea—d 70Oy 7 FE#EIRL T, A=—N—=54 K
B LUEFH (Override and Update)] ZEIRT 272157 T. BHEONENY —/N—
M5O —REINET,

o WMNEFEMRAELZEGEE. TFM (Synchronize)] E2—D =M A =2 —%7)l
LT, T774)IVABDLEE (Compare File Contents)] Z#iRd 2 Z &
INTEET, BAULHDIEEZITD E ERICTERS 77 A IIVDOHD [HEH
(Synchronize)] Ea—IZF/RINET, KiZ. [[EH (Synchronize)| E o —7Zfif
HLTINGDOFEZMIRT L ENTEET,

D—OAR—=R -TalbobU-4tTTOD Y FDERREND
TIAINETIE, 70227 MIT—DVAR—=Z + T4 L7 M) —ITERENE
To TOT 73N REF—N—FA4 RL T2y NZEHOGAIIERT 256
12, D= XRFEHACDENCTIRTOT O 27 hERSSBERHDET, N
IZED, 207027 b® project 7 7 AIVN#EY) RO —2 g ICESIAEN
9, T4 LT MN)—=NT—=I ZAXR=ZDIMINCH BT 027 hEHL Z
EMTERWE, EBOTOD 2V NERAVT57070 7 RIMERSIN., =2
IZ1d .project 7 7 T IVLINAD K A

JSP 7L =9 RS FOBERENVLE
BERESNTNDEZTXRTD ISP TL—URA1 > h2RELT. ThozEIA1 7L
— g EARN—Ta> 5 T AR—ZANICHEHEZET D2HENH D T,

4.03 Web 7Oz bDYV—2aF - T—HDR(I -3
IBM WebSphere Studio Site Developer 403 O 70Oz 7 ks UL —aF)b -
T—=HEIATL—ar 51203 LFOLSICLET,

1. IBM WebSphere Studio Site Developer 4.0.3 D7 —27 ZAX—ZAN5, 0§
BT —HN—=AIZxT 5 DDL 7 7 A IV E4KT %,

2. Web 7O 27 hDY—AT—=FR=Z « TH )T —=INET—F R— 2=k
T2 ( [F—%EFK (Data Definition)] E = —Z ).

3. IBM WebSphere Studio Site Developer /N\—23 > 5 T 4.03 OU—7 AX—2A
ZH <,

4. JL—aF) - F—FZEZETLLZW Web 7OV b EIXATL—2 3>
5,
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5. TZ74) (File)l > T4 >iR—bF (Import)] > (7 7A4J)L « AT L (File
System)] 27 Uwv - L, 403 U= AX—=AM5 DDL 77 A IVERET
b

6. [5—% (Data)] N—AXRT T4 TD [T—4EFH (Data Definition)] E 21—
T. A—H)IZx L THEIT (Run against Local)] Z&ERL T, ¥—7 v b
Web 70227 hERET 5.

Jb—>aF - =Y ORRMMNETTINET,

4.0.x M5 Web Y—ER - 274NV %&AL R—PLEED
WSDL IT5—

40x M5B Web U—ERX - 7712 >Hh—hrT2E, UFOTT— - Avt—
DEZITWABELEENH D ET,

Error The part 'result' has an invalid value 'anyElement'
defined for its type. Type declarations must refer to
valid values defined in a schema.

Error The part 'return' has an invalid

value 'findPatientResult' defined for its element.
ETement declarations must refer to valid values
defined in a schema.

Error The part 'response' has an invalid

value 'findPatientResponse' defined for its element.
Element declarations must refer to valid values
defined in a schema.

ZOILT—DXEIZ, U FTDOEBD T,
1. WSDL 7 7 1)V ZHIBRT %,
2. Web ¥—EZ « T4 ¥ —REHFETL T, Web Y—EZXZHLERT 5,

J2EE 702 1Y MEEELIWE /IS J2EE L ANIVDRA I — 3
v
N—2a> 5 ® REE XA L — a2 U4 PF—RIZTI7ELATHITIILLTFDA
T T T I,
1. 7Oy NERIRT 5,
2. FOTOT Y NEHARIARY T U LT, R R4 b—=a>y
(Migrate)] > [J2EE Y44 L —> 3> - U4 ¥ — K (J2EE Migration
Wizard)] Z#IRT 2, XML —2a a4 RTHI4HF—=RDATv 7
> TLEE N,
3. 0yl MY —ZHIEO FIZh 2 5E13. ToEEEtInNETo s b
Z SCM MRET 5,
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8 6 & WebSphere Studio "Classic” 5 IBM WebSphere
Studio Site Developer AND?A L — 3>

ZDETIX. WebSphere Studio /N—a > 40 (Y RN ARMRETOT v 3

FIVERDW ) 775 IBM WebSphere Studio Site Developer IZX1 27 L —2a>9 5%

FiEZEFHHL £9 . WebSphere Studio "Classic” /N—3 3 > 4.0 205 IBM

WebSphere Studio Site Developer /N\—a > 50 NOX AV L — a3, LLFD

ATy TINEE> TWET,

L XAT7Lb—=2a VHITHLWS 2 D)L« ==« AT =D &/ElT %,

2. Web HpECIET 7 7 1 IV 2R T %,

3. XML —>3 > JAR 77 A INV&LV AR—hT %,

4, X142 L—a> JAR 771 )% IBM WebSphere Studio Site Developer {Z-T
>AR—hT 3%,

5. U=N—%ky b7y TLT. XMTVL—=2a FAHOT TUTr—a &5 A
9%,

E: DUROFBHIZ. WebSphere Studio /N—3 > 4.0 N65DXA VL — 3 > &xf
G &L TWET, WebSphere Studio DZNLARTION—2a > s AT L —
a >3 55513, £9 WebSphere Studio 4.0 XA 7L —a>LThb
IBM WebSphere Studio Site Developer IZX 12/ L —2 a3 > LTSI,

WebSphere Studio "Classic” DILIENAT 4 —F v — (7 7 A I ZEZRHAT—IITR
v 7T HHRE) BL N Page Detailer 7 4 —F ¥ — (Web RX—T D7) 13 IBM
WebSphere Studio Site Developer TIIfEHTEEH A, /N—3 > 40x CD AT
AT N ITDEOMDT 4 —F v —D—HbHEHTE A, LEZIE Web X
— D ZENHIT S Page Detailer 74 —F ¥ —, UvF - AT 47 « ¥4 THD
HotMedia® 7 4 —F ¥ —. Voice XML L7 1 % — (WebSphere Everyplace™ Y —Jl
FyhER=F) - V—I)bFy bABINELE)., X—XRATT - TNAZHD
DataBaseWizard 732 DH#| T,

WebSphere Studio DT —% <A 7L —3 a3 > 955513, LITOHIBRFHREICER
LTSN,

+ IBM WebSphere Studio Site Developer {3 XML X—Z® SQL LT 1 ¥ —%{f
ALTWS7ZD, sq 77 MIVIEIEHTEEXRE A,

« TOPx ) bORFEREAT—VHEREIA L — a2 TEHILERATERE
/lJO

* WebSphere Studio DY —/N—HkiEHZEZ~Y 1 /L —2 3295 LI TEER
/1/0

s N—=2a VEMEREY AL —23 295 EETTEEEA,

DRICHAT B YA L —a > - 7Ot AHIZ, WebSphere Studio (&, 27
W H—N—HOITXRTOTO I b+ 7710V (RERERHDEY — ) &I
Wiz JAR 7 7 A IIVEERL £, [ABH (Publishing)] Ea—Il& RSN, T
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THAINE - H=N=DT7 714)VTTXRT, JAR 77 1IN\ Tr—I3INET,
JAR 7 7 J)LiZ IBM WebSphere Studio Site Developer |21 > h— M TE £,

WEOTOD ) hexXA L —2a 3258, 700z FOREERE AT
— VI, ITRTYA T L —2 3 VRITHRL LT, AT =M OT—/)N—
ICEMBEEIE. T 74N b - = N—ZRHSINE T 7y MV UDMRESNEY
lo LIz T, XA L—2a 2HELT, U=N=0 1 DETOHLWAT—
TaERLET,

RATV—=2a > DEODFR T - =)=« ATF—=DIERR
BITOAT—ICEROY—N—0b 55513, UTFTOATy TE2FETLT. 1 D
DY —=NN—DHD [Migration] ENIHFHLNWAT—TZIERL ET

1. T7a2zs b (Project)] > IRFART—CDHREY T4 X (Customize
Publishing Stages)] Z7 U w79 %,

2. TRF—T% (Stage name)l 7« —)L RIZ Migration & AT %,

3. EM (Add)] 227U w295,

4. TOK] 227Uy rd 5,

5. T7Aa>xo b (Project)] > TABRF—< (Publishing Stage)l =7 1) v 7
LT, #BRAGERAT—DU A0S R4S L—2 3 (Migration)] %
ERT 5,

6. [XBHH (Publishing)] E2—7T. T[4&A (Insert)] > [ —/\— (Server)] %7
Jw 9%,

7. localhost 72 EDY—N—H%% AT 5,

8. W—N—2ZZHL/ZD, RAAT—TZZEHLZDLTH,. WebSphere
Application Server /N—3 > 40 OY—T L v bk - v ETERITER SN
Ft ., B (Publishing)] Ea—IZ¥v > LT, =Tl v I &I
[70/87 4« — (Properties)] > [/AB (Publishing)l > —7 L v k- <y
E> 4 (Serviet Mapping)l 27 Uy 27 LT, EEOY—TLvbh- -<vvE>
JEIAE—T 5,

Web #8RKECRF 7 7 1 IVDVERK
1. 7oz k- 774)-Ea—7T. APz 4 F (Project)] > 'Web kK
il F 7 7 4 )LDYERK (Create Web Configuration Descriptor File)] %7 1
V79 %,
2. MERY—T Ly hETXRTERT S,
3. MEREY YT - T4 T 5 —fik T (TLD) 7 7 1 IV E T RTERT 2,
4. THERR (Create)l =71 v 79 %,

T 73V hD Web #ECR T 7 7 1 IVEIE serverName_web.xml T9 ., Z Z T,
localhost_web.xml (2720 F9, ploasr— a3 > Z2BELLWED, xml 771)
!Z WEB-INF 7« L7 ) —IZREINET,
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A4 V=3 JAR 774IDITH RAKR— b

1.

2.

4.

6.

70z 2 bk« 77A4)b (project file)] £ —T, ¥ —/\— localhost % #{R
LT I'70/85 4« — (Properties)] > /2B (Publishing)] > 'WebApp Web
/XA (WebApp Web Path)l 271>~ L., myWebPath 72E®D Web /NA (O
STFARI)—b) ZANT S, AL, WebSphere Application Server -
Express D707 ML L THEHINET,

7oz s bk« 774) (project file)] Ea—7T. 7AYo b
(Project)] > R4 L—3> - 774 I)LDOIER (Create Migration file)] %
ERT 5,

B —/N—& LT localhost 7NERINTWNS Z & ZEMRT %,
Web HERFLIR T 7 7 1)L & LT localhost_web.xml 2GER I N TS Z & 25
wd 5,

0Kl 227U w74 %,

F7 )V E®D JAR 7 71 IL£IE serverName.jar T, I ZTld. localhostjar
WD ET, BEIECT, 77 A NVAEEELET,
JAR 7 7 A IIVERET %,

R4 b—3y JAR 774JbD IBM WebSphere Studio Site
Developer "DA »R— b

1.
2.

4.

6.

IBM WebSphere Studio Site Developer ZUHEIT %,

Web 702”7 h&EIERT S (7 74)0 (File)l > T#RIERL (New)l > [

O x4 b (Project)] > TWeb 7O x4 I (Web Project)] ).

70>z b4 (Project name)l 7 ¢ —JL RIZ Web 7Oz 7 kD4 %
ANT 2, ZO4HENT, B3 X=2) I*A 7L — 32 JAR 77 1)L D|
T AR R0t r>a>0ATy 7 | CHE LA &R TR drs
DER A
FTTOA A REHNET S Fill Web 7027 MEEOHREZIIEEEFD
EAR 70O /7 hNAZERET %,

M 57+X b - Jb—F (Context Root)l 7 ¢ —JL RIZ. WebSphere Studio
TYA 7L —a32 JAR 771 )VEE L7z & EITHE L7z Webapp Web /¥
A% ANT 5, 4T (Finish)l 227U v 7§ 5%,

[FE4S —%— (Navigator)] Ea2—"T., fERRLZIENDD Web 7OV 7 b &
BT 5,

JAR 7740V &EA > H— 1T %,

a. [Z74)V (File)l > T4 >R—F (Import)] 271 v o9 2%,

b. TWAR Z74J)L (WAR file)] 22717 LT, RN (Next)l 2271 v/
95, JAR 77 1)V WAR 77 () - A7 azFHLTA>AR—KL
HIFIULE D FEA, FOLAaWE, ELLFELZE A,

c. TWAR Z774J)L (WAR File)] 7 ¢ —)L FIZ localhostjar D/NA % AT %
»n. TS (Browse)l 27U w7 L THETSZ (FI7TXTESHDIE WAR
#7200 T, JAR AIITEEHA).
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d. I—H—OERLEEGFED Web 7027 h&ERT S, TATF+FR
k- Jb— b (Context Root)l 7 ¢ —) )l RIZIZLARGHRE L 7=l HEIIC AT
INET,

e. [#7T (Finish)l 227U vy 2-7 3%, [UYV—X WEB-INF/web.xml [£T TICTF
ELTWET, EEELET D ? (Resource WEB-INF/web.xml already
exists. Would you like to overwrite it?)] EWHEMDY 1 70O MNE
NEJ,

f. TI&LY (Yes)] Z3#IRL. IBM WebSphere Studio Site Developer IZ
localhost.jar ZfRE S H 5,

8. RFFFDOBMORELZA AR —K « Ty AINHUX, ¥ A (Tasks)] E
A—IZFERSINET, BIETSHITIE. Web 70227 RO Java EJVE - XA %
EHE U0 £8 .

a. JOPx Y MR TA R T Uw LT, 7ANRT4—
(Properties)] > lJava EJL K - /XX (Java Build Path)] =7 U w79
%)o

b. 54751 — (Libraries)] ¥ 7% 27U w4 %, 48 JAR DiEN
(Add External JARs)] 271w 7§ %,

c. ROT ALY N)—InSEIR JAR &1 2R —hd %,

o WS_Installdir/runtimes/aes_v4/lib 3 LN
* WS_Installdir/runtimes/base_v4/lib

9. [FTES—%— (Navigator)] E2—T, YOz hEEIYTA - Ry > TUY

w27 LT, 172z bOBEJLK (Rebuild Project)] #i#RT 5,

TAN Y= N=LTOA V=23 FHTTVT—3 DT R
TIT) =23 BT ANTBEFENENELRE, T FIEDT AR - H—)N—
Ty TV r—23 2T ARNTAEE13. UTFTOATy TE2ETLTLIIZEE N,
1. EAR 7OV 7 hEHAXTA Ry > T UwIT 5,
2. T[H#—/N\—T%1T (Run on Server)] %&ERNT %,
TI AN NUSNDT—N=F A LRETY U —2a &7 AN 256
iZ. F>I14>2 - ANIVTT [H—)N— « V—) (Server Tools)] 7 4 —F v — 2%
LTL7ZE N,
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88 7 & VisualAge for Java 5 IBM WebSphere Studio
Site Developer "D A L —< 3>

ZDFETIE, VisualAge® for Java 7O 7 = v aF)LKEIT VisualAge for Java
I>%—754 Xfk%Z IBM WebSphere Studio Site Developer IZ<¥ 127 L — 3 >
IL5HEEFILET,

E: ZOETRLTWASFIEIL, Windows iRD VisualAge for Java /N—7 3 >
353 £ 40 S5 ATL—2 32T 2HDDOBOTY, HN—T3 >0
VisualAge for Java 7% IBM WebSphere Studio Site Developer (¥ 27 L —
a 355513 £TIH/N—3 > VisualAge for Java 2" F7z13
Windows fRD/N—7a > 353 £/213 40 TRA 7L —2a>LThs,

IBM WebSphere Studio Site Developer \ZX{ 27 L —2a > L TL/ZIW,

E: m™ [BM OED XA - /)N—hF—TbH5 Instantiations, Inc. 23 L TN D
CodePro Studio EWHEHIZIL, YA VL — a VHRER L OHFHKEN H
0. VisualAge for Java & WebSphere Application Server - Express D4 pENE%
M EXIHET, VisualAge for Java DIL—H =N A VL — a »ZHIETE
%X D1, Instantiations (&, MBI THIHBIR D72 VisualAge for Java % IBM
WebSphere Studio Site Developer 727 A7R— MHEIZ CodePro Studio O HIfHIBR
EFER DO —ER & U TR L TWET . -,
|[www.instantiations.com/vaj-migrate| 7" 54 7 > O — RTEET, 77 (I D%EE
MABLY ZAR—b/A 2R—b, TZAR—b/A2HR—b -y DR, 7
oYx7 boFEFE. ¥ A7 OHEERE, 1 ALY > ALDIER A T L —
g EHEYR—FOFEMICDOWTIE,  Instantiations, Inc. @ Web R—
[www instantiations.com/codepro/ws| & Z ML T< 723 1,

VisualAge for

Java & IBM WebSphere Studio Site Developer D#H5E

PUFIZ. VisualAge for Java M5 DEE LD —H2 U A ML ET,

 Enterprise Java Beans (EIB) fLEkL ~)L3, 1.0 56 1.1 WEAEINELE
(WebSphere Application Server /N\— 3 > 5 770 anNs7 7 r—a >
Tlid. EJB 2.0 Y R—FEINET).

s Web 77U —2adfFE, ISP LANJUE 1.1 OEFETT (WebSphere
Application Server /N—>a > 5 77U —2 a > OEAEIT 1.2).

« Web 77U —2a 0BG, =Ty b LT 22 DEXTT
(WebSphere Application Server /N— 3 > 5 77U —a > OEFAEIT 2.3).

« YR—FEN% Java2 7TV b T —LDLN)VN 12 5 1.3 ITEESNE
L7z (@21 7—13 1.4 O—REKRZEITD TENTEE9 ). WebSphere
Application Server 7 2% 1 LEREEIX 1.3 OFETI),

* Visual Composition Editor 4% Visual Editor for Java IZEZHZ 5NEL .
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VisualAge for Java N— a3 JEBETOTIITHYY— Y —Z « I—R - YR
DRU=D, VT T THRRERE (SCM) 7T A T S YR — MCEE
HZ5NELT,

VisualAge for Java Tools API 7%, WebSphere Studio Workbench 75271 > + 7
—F T Fr—ICESHWMASNE L,

VisualAge for Java XML Y —JL73, IBM WebSphere Studio Site Developer XML
VoWCEEMA S NE LT,

VisualAge for Java 7O =7 MERN, &4~ 1 7D IBM WebSphere Studio
Site Developer 7O =7 MIEZHASNE L,

VisualAge for Java WD A I L —> 3

AR D AT v 713, VisualAge for Java M5 A T L —a >3 5 HEERLEHD
TY, ZOHT, TNETND AT v TOEITHIEZFLSFHHLET,

1.

oo

VisualAge for Java V5D Java 77 ) BEAXT7O 7 k- JJ—Z - 7 7|
VDT Ah—H
IBM WebSphere Studio Site Developer DfE), BEIRI—RICEDSH L W]
0”7 b OERK

bava Ty ETOY 7 k- YUY —Z - 77 1)LD IBM WebSphere Studiol

Site Developer ~D1 > 7h— K|

webxml L5 ¥ —&fHLE, =T L v FDNELERINTWVNDS Z & DR
78 (Web 7O 7 hDA), |

o7 FEEET— IV AR—AREDIA T L — 3 |

—N—Dty 87 v TBEINIA T L —2a BEADOT T r— a2 D A
1]
[[BM WebSphere Studio Site Developer 75 WebSphere Application Server \ Q)|
["7Vr— a3 oF7ofq]

F‘E%{@Fﬁ%%%ﬁf‘@ IBM WebSphere Studio Site Developer 7 0 = 7 ha%E D)
B G~ 7L —>3a )

VisualAge for Java M5® Java Z7MIELo7Oo o b -

VY—=R-T7L4IVDITI RAR— |
VisualAge for Java YR MU —moN—D g YEHINZ7O2 7 YUY —2
T [FEDT) AT L —2a 95 HEFYR—FINTWER A, VisualAge
for Java =V AR—AZHBH 707 NV —AEFEIA L —2a > T
EFET, N—ra EHINLZTOD2Y MUY —RIE. £9 VisualAge for Java
= AR—AIZBH L THNS IBM WebSphere Studio Site Developer {21 2/ L
—2ar I ARENHDET,

F o0 oy MCEROFEEOT—4 A, T2 —7 T4 X Bean & Java

V=« d—=R + T714)L) WA TWBEAIL, 1 S ITHEDWTT—F 2
Z®D JAR IZHELTL7ZE 0,
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702z bE JAR 77 ANV AR— T 2581F. UFOATYy 7&FETL

TL/ZEn,

. TVZAR—FrT270Y Y NOBIE VisualAge for Java 7 —727 AX— AWIT7%
WEBIX, U= AX—=ZEMT %,

2. [VisualAge for Java 77— N> F (VisualAge for Java Workbench)| ™7 1 > R™J
T, JOPz ) MEBRLULTHEHY YA - RAF>Tr7Uy oL, TZHRKR—b
(Export)l 2271 w79 5,

3. TJAR 774 (Jar file)] T4 - RY L EBIRLT. TRA (Next)] %7
w2795,

4. JAR 77 1)V DA4FIZIRET .

5. Tjaval Fxv 7 Ry A&ERLT Java 77 A NVELZI AKR—KL. TU
Y —2R (resources)] Frv/7 Ky AEERLTUY—RA - Ty AIVELY
AR— KT %,

6. BHEIZLU T, TOMDT 4 —IV RICATIT B, TOEEDETHEDFHMIZD
WTIE,  VisualAge for Java DA > T > - NV TEBRLTLIZI N,

IBM WebSphere Studio Site Developer D). LU a—F
ICEHIMLNTOT I FOEK

IBM WebSphere Studio Site Developer ZAENL . FTEO 7O 7 h&EIERKL £
T, AR 7740V DA > h— R &72% IBM WebSphere Studio Site Developer
Ty NOFEEERDDGEITHRLD, BB IA L —ar s HA RS
1 >TY,
« =R Web 77U T =23 >0—WTHZLHEIR, TDI—F%Z Web 71
PV MIA CAR—FT B,
~ Java 77 1JUIFTXT Web 7027 FdD Java V—R - T4 L7 bU—IC
A1 >R —1r9 % ( IBM WebSphere Studio Site Developer 2L D, /Swir—
DAT—h A2 MIEDEEU BN BRI NET).
- UY—Z -+ T7A)UTTRT Web 7O0PxV ~D Web ATV - T4 L
7R =2 AR — T 5,
o O— RDPHMEHEZR Java (BIZIE, AY > R7 O TEITSNET TUr—23 )
DHFEE, £DA—F%Z Java 70TV MZA 2 R—FT 5%,

E AR, EOFEEED IBM WebSphere Studio Site Developer 7127 bk
EHEATOINERDD ETORWRTA RIA ICHEETA, 7OV Y
NEERLIZD, O—R&2A 2R —FLAEDT25EG1L FailZ IBM
WebSphere Studio Site Developer DA > T > « NIV T ESZHL, SO
WebSphere Application Server - Express 7O =7 haX<HEML THB &
ZPREOLET,

Java 774I)IVEVY—R - 7 74)b®D IBM WebSphere Studio
Site Developer ADA Y R— b

1. IBM WebSphere Studio Site Developer ZB&. [U—XZ (Resource)| /¥— A
774 TIYOEZ %,

2. T774JL (File)] > T4 #K—k (Import)] > [ZIP 77 1)L (Zip file)] %7
w29 %, RN (Next)l 271w r7d %,
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3. WMRD JAR 7y MIVESRT 5,

4. 12K —rTB5T7714). BTy EANS O NERRZT+IVY
—ZBENT %,
E:
« ZIP 1 >AHR—FDRODIZT 7 A« AT LDA >AR—MbHEHMEETT
M. ZIP A 2R—bDHNED R TY. A >AR—b - TP —K ZfA
LT ZIP 77 AL HR— T HDTRHR, TANY—&BELTT 71
WA DR—=FT2ZEICDWTHRUHFHANHHATEET,
« 771)L% IBM WebSphere Studio Site Developer {Z-f > H— hT 255G
W, YR T4 L PU—ICANSLDICLTLEEI W, I—R&EA 2 h—
N9 58513, FRilC IBM WebSphere Studio Site Developer OF > 51
e NITESRLU, £FO IBM WebSphere Studio Site Developer 7113
TV hEX<HMLTHLILZ2BEOLET., LTIy —ICEDT—
REANDNZHHIT HBRITETLB X,

B—TVy MPELKEESINTNWSZ LZHDRTH=0HD
web.xml T7 14 ¥ —DfEH (Web A2 Y bDH)

7TV —2a T =7 Ly hEFHAL TWSEAEIE. webxml 77 )L TH—

TLwhE URL DXV E T EZERTIHENHODET, LUTFTOATY T2ET

LTL7ZSaN,

1. TWeb) N—=AXZT T4 7T, webxml 77 1IEH<., ZO77A1)id. Web

70 x 2 F® Web Content/WEB-INF 75 (¢ L7 U —IZA> TWET,

Y—J L v b (Serviets)] ¥ 771Uy 7d 5%,

NEM (Add)] 227U LT, TH—=TLwv bk (Serviet)] 5A - Ky > %

BEIRT B,

4. =Tl v hO4RTEANI LT, TOKI 271w 5%,

. 8B (Browse)l 27w/ LT, =7l v k-5 (Serviet class)]
Dz @Y /)N T — PR EET B,

6. X7 ar) #rld, =Ty bOEMICHEHAT S a—b - xF—ALTT,
I&X’~% (Display name)l 7 1+ —J)LRIZ, =T L v kD a—hk- - Fx—L%
AT 5,

7. URL XvE>ZT, Y—7L v k& URL N¥—2%2FF*T 5, TURL ¥vE
>4 (URL mappings)] 7« —)L RO#IZH S TEM (Add)] ~F > %7y
7L, URL X E T D4R ZANT 5,

8. BHEMREL T (IZ74J (File)l > Tweb.xml DRE (Save web.xml)] ).
web.xml 77 1IVZEAL %,

wo»

APz MREELET—VAR—ABEDRAIV—ay

PAUF @ VisualAge for Java axiE 2HE . IBM WebSphere Studio Site Developer
THRELTL/Z3N,

s ok 578 NOL/A> S YAV

o Uy — ABYHE

e A—RD7#+—<v hi%E
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« WTE OREK
e Java 77N BXAX 7oz U= - T A))

702 bDYU SRR

VisualAge for Java Tl&. [F 72 3> (Options)] T4 > RTD [V —2A
(Resources)| X— ([ 4> R (Window)l > T+ 3 (Options)] > TU YV
—2X (Resources)] ) T. 7O/ "D ITANAERELET, YOV b
% IBM WebSphere Studio Site Developer ICX¥ 1 /L —a> LT/ oozy
KDY FANAEZRETHI2IT, 7Oy O [770/8F ¢ — (Properties)] ™7 A
CRUEERALEYT (O hEAYTA - RY T Yy LT, AN
T 4 — (Properties)] > Java EJL K - /¥R (Java Build Path)] Z#E{RL £
) [ZA475YU— (Libraries)] ¥ 727Uy 7 LT, £k, [FE
(Preferences)] A4 > R TY IANADEREHETHIEDTEET (U4
K™ (Window)] > &% (Preferences)] > [Javal > [V 5 R/NRZEH
(Classpath Variables)] ).

)y —RE8E

Ty« YA T EEFARETOV I AEOBEZ Y b7 v UL TU— R
CFDOIMINCH B T 7 AN T =R FORMNSIHS T ENTEET,

VisualAge for Java Tld. [ 7 3> (Options)] 74 > RUTYY— ZARH %t
w7y T LET (94> KD (Window)l > I+ 3> (Options)l > VY
— X (Resources)| > )V —XB§;&E (Resource Associations)] ) UV —XA -
7 71 )% IBM WebSphere Studio Site Developer {Z¥ 1 7' L — a > L7z#&Iic)
V—AB#EE Yy 8T v 7951213, TERE (Preferences)] 4 > RUZMHAL £
9 (4> KD (Window)l > TE%%E (Preferences)] > (7 —O XV F
(Workbench)l > 7 7 1 JVE8:E (File Associations)] ).

A=k - T74—vF—

VisualAge for Java Tld. [ 7 a3 (Options)] T4 > RUD [T —<wEH—
(Formatter)] R— T, I—RDT74—~<Xv k- FTF>a> 2ty 7y 7 LET
(T4 > RY (Window)] > T+ 3> (Options)l > TaA—5F4 >4

(Coding)l > 17 +—~< v % — (Formatter)] ). J— K% IBM WebSphere Studio
Site Developer ICXA 27 L —2a>LBICA—ROT+—~x v FREZLZY b7 v
T BN TFRE (Preferences)] V4 > RUZEFHLET (D4 KD
(Window)] > 5% (Preferences)] > [Javal > IO—FR - 7+ —<v 4% — (Code
Formatter)] ).

WTE DR

VisualAge for Java T, WebSphere Hi{AT A hEREE L WebSphere Application
Server T >4 A LADREL. VisualAgelnstalldir¥ide¥project_resources¥IBM WebSphere
Test Environment¥properties 7 A L' 27 & U — (VisualAgelnstalldir 13, D1 > Xk
=N TFTA4LZ M=) OFOIEIERTONT 4 —+ Ty AIVITA-DTVE
ER

Bl Z 13, sessionxml 7 O/)NTF 44—+« T 71 )V T,
<url-rewriting-enabled>true</url-rewriting-enabled> O Xz 7 O/\5 1 —%
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true IZZ88 LT URL HEHEAAZMEHPEEIC L/2E. IBM WebSphere Studio
Site Developer /N\—23 > 4.0 7 A MEET, 207071 —ZHRTE X7,
( T —/N— (Server)] /N—AXRT T4 7T, IH—/N—HEHL (Server
Configuration)| Ea—2E, FIHLEWY—N—24LAY T A - R > TOU v
L. < (Open)) #2VUwrd%, [Webl ¥7%71UwZ7 LT, TURL BE
ZiAHE(FERATIHEIZT S (Enable URL rewrite)] v 7 « iRy 7 X Z28IRT
2o )

Java 77L& 7aC o - VY= -T7AM)

70)NT 4 — + 7 71l default.servlet_engine Z1&. VisualAge for Java Web 7 7
Ur—2a>® <rooturi> A>TF AL - JL—FWAS>TWETY, IBM WebSphere
Studio Site Developer T Web 727 ME{ERT 2. TWeb 7O b
DYERX (Create a Web Project)] #7027z, ZOT—4® IAVTFFX b -
Jb— b (Context root)] 74—V RRHD LT,

I—HY—INEHSNAZ A X U7z, VisualAgelnstalldir ¥ide¥project_resources¥IBM
WebSphere Test
Environment¥hosts¥default_host¥default_app¥servlets¥default_app.webapp 72 ED 7 7 A1
WD Web 77U r— a3 2aElX.  IBM WebSphere Studio Site Developer @
your_Web_project¥Web Content¥WEB-INF¥web.xml 7 7 LI A VL —2a > § 5
BN O ET, HIlAIE. default_app.webapp 7 7 1IN TH—T L v ha&EH—T L
vk e NAZEERLUESEIE. webxml 77 M)V THMINT H2EHEEITNET,

WebSphere V4 TR MNRIEDEY b7 v TERAM I V= aViE
BTTVTr—2a>DFR b+
77U = a it Java 7OY 7 FOHFEIR, Java T 0T F MR B ENE
@ IBM WebSphere Studio Site Developer @E{T (Run) R — M E/zldTF /Ny
(Debug) F+E— NG EMHHLTEDT FUr—2 a2 &5 A FLET.

7 74— a3 >/ WebSphere Application Server 2 L TWAHETT, AR
& WebSphere Application Server ZfiHH L TZD 7Y 7Ur—a &5 AL E

T ZOEDIFE. TIAIVEDOT AL - = N—Z/ER L T, HEIT50ENDH
DEJ., Web 7OZx7 FOHFIE. A2 HIML XR—JZHITA - RY 2T
70w L, TH—/N—TRT (Run on Server)] ZiERL T, Web 7T H—
ZHEELET,

ZTOMDYA TOTOP 7 bOTARNFHEIIDOWTIE, F2I714>2 - NIV T 2B
BLTLZEWN,

IBM WebSphere Studio Site Developer /5 U E— b
WebSphere Application Server ADF7 FU4—> 30570
4

WebSphere Application Server 27 > 1 LAREE L THHL TWAHEIT. IBM
WebSphere Studio Site Developer® [t —/N— «*—)JL (Server Tool)] 7 A —F v —
EERALTY YU r—2arz27 7014 L&Y,
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EHORFEEETO IBM WebSphere Studio Site Developer 7
O ) FREDOHA (BRRAIL—23Y)

IBM WebSphere Studio Site Developer 7T =7 ~ (BX U DBHET 5 #%E)

. HEEMTHEATAZENTEXY, 20D, Jorzs & IBM

WebSphere Studio Site Developer MY 7 b7 = 7HERREEE (SCM) B —/N\N—IZHRE L

T/M5. IBM WebSphere Studio Site Developer DBIDF— L = A2 /N—IZHD
L£7,

IBM WebSphere Studio Site Developer DF—A - HR— |k

IBM WebSphere Studio Site Developer /N—33 > 4.0 OF — L « HHE— MMZIDNT
(=8

|www.ibm.com/websphere/developer/library/techarticles/O 108_karasiuk/01 OS_karasiuk.htmll
EHRLTEI N,

F7-. IBM WebSphere Studio Site Developer DF— L + HR— MIDWTIZ,
(A AR=)V - HA R RF T2 - NVTHBEITRDET,

% 7 ¥ VisualAge for Java 75 IBM WebSphere Studio Site Developer "D< 1 7L — 3> 51
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% 8 & VisualAge for Java Visual Composition Editor M5
Visual Editor for Java \D3A4 5 b — 3>

ZDETIL, VisualAge for Java @ Visual Composition Editor 7 4 —F ¥ — TERK
L7=7 7Usr—3 3 % WebSphere Application Server - Express ¢ Visual Editor
for Java XA L —3 a3 > 95 4EEHAL £,

¢ VisualAge for Java N SILIRFXEIRF A ¥ T — ¥ 2 RET 2,

XA L —a > %&5%E 795 (WebSphere Studio A > 7h— K9 %),

VisualAge for Java M5 DHREREIFA Y T — 9 DRE
COATY T3 A T a > TINUTFORBIDID, FeiZ, 77U Tr—3a »itk
GEINTVHHAID) B BEBLET,

VisualAge for Java |&. 7U—+ 74 —LEOD kv 7L X)L Bean OELEICEAT
HIERIIAE L EHATLE (D Bean WIZHAIAE 72 Bean MdrdH Z &
BEHRLTWETD), Z3UTH L T. WebSphere Studio 1312 Z DIEHZ Bean %
HE95I—FTIZOAMELTHREL, Visual Editor 2511 /2 & 1T Bean
ZNOHF Y ONADEUCAEICEILL T, ZOD VisualAge for Java DF%alHEE
Bz, XA 7L —2a > 35 ETL24H T2 andbDxd, TOEhRE
BRE LRWEEIX, ®OIZ java 7 7 1)L Z#H L Visual Editor for Java 125 <
L ITAS—E by TN (T = T —L - N=VELTHSNTND)
Bean D7 7 4 )V MIEZFHELET., ZO Ly 7L X)L Bean 1T RT VT - 7 >
R ROy 7HECHBICAETE LT,
WebSphere Application Server - Express D#i#i Visual Editor for Java OFJHH/N—
TVald, BERERETE YR — N LEREAN, R, ZNITET N DO DE%
BEREMEM I NS AREENH D £9 CF: ZUIHHBII v M A FTIEARLS, B
RAFPEROAIFEEZ R RTINS ITBEEEA).

ATV =33 CORNTHERA Y T — 5 1EHR & RE T 5 ik

1.

VisualAge for Java BHFEH B A1 >
[[www.software.ibm.com/vad.com/vad/data/document4293| 1Z#&)L T. IBM VCE
Code Generation and Export Utility &% > O—RLET,

Y —)L®D README 27> T, Y —JL% VisualAge for Java IZiBML. KICT
VisualAge for Java % FIGENT %,

WEDTY FUr—3 3>« 23— K% VisualAge for Java URY b U —~ANAFLTN
—2a EHTS (L > T, VisualAge for Java BAFEZHED TWNHHEIT,
ZDN—T a3 VICRT ZENTEED),

TNZND VisualAge for Java NOKIEY 7V r—2a>Z&ic, K707 5
A (GEE. XxxxxView) ZERL T, AYTA Ry T Uw oL, LFDA
Tv T EFTT S,
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a. [VCE O—R4&RK /| T4 RR— b+ (VCE Code Generation/Export)] % 77
w27 LT, TA—FRERRBICTA VI M)—=AITHRKR—FT S (Export
to a directory after code regeneration)] *+ 7' 3 > ZRIIKEDE LI
I %,

b. T#7T (Finish)l 271U v 795,

c. F4UL2% kY— (Directory)l =T/ Ar— NFEdEd U TERRIREEIZL T,

IR~ (Next)l 227U w795,

d =7 v bh-T4 L7 N)—ZRBIRLT, .class 7> = > &BINMRL

IHIC (V=R - O— RPN ER/=0D) java &7 a > &2ERL T, KiC
M427T (Finish)] 227U v 79§ 5%,

e. A7 arE LT, BiDO/N— 3 > D VisualAge for Java 1— REFHDO— R
T35 (HAXUARY>>TOUw LT, 7FU5—2 3 %2BELTESE
#1Z (Replace with)] > IRIDI T 1 3> (Previous edition)] Z#{RY
;a))o

R4 V=23 DRET (WebSphere Studio N »R— )
ZHT. 7T A% WebSphere Application Server - Express |2 > 7h— K T&E 5 4k5E
IZ72DE L7z, mithad4s XR—2@ T8 7 & VisualAge for Java 725 IBM|
[WebSphere Studio Site Developer NDX A 7 L — 3 2] EBRLTLI/ZI W0, #
S} Visual Composition Editor */—Z « 71074 5 /\% WebSphere Application Server
- BExpress 121 > — L THBITIE. £ 5% Visual Editor for Java TR5FT S
EMTEET,
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FIOE ENF-EYLTYT (3475 U—. JAR. HETOD
x4 b JAR. Ant EJVF)

ZOETIE, UFOXA L —ar - NEvIZZRD ETET,

e Java 71 7FYU— JAR BLUOY—R - )X—F ¢ —4E JAR

s @70/ K JAR ZEHLAXIVF 7O s b - E)L RORK#EL
o Ant ZffFHLZHEMLEBEIL R

Java 5475 — JAR 8XUPY—F - X—F 1 —4188 JAR
B EIHOFEMICDOWTIE, 2EE 77X - O— RICEHT 2 &H
(www.ibm.com/websphere/developer/library/techarticles/0112_deboer/deboer.html) (J2EE
EDa—IIEYTANA), BELW 2EE 1—F ¢ UF ¢ — JAR OBFFBICETIE
Bl (www.ibm.com/websphere/developer/library/techarticles/0112_deboer/deboer2.htmll)
(J2EE £ 2—)V® Java JAR) 2L T<EI W0, INSOERNI, FHl 7zl
WRIN 7759 RET RINA Azt L7,

Web 7O2xH bTH—F - N—FT 14— JAR 2FERATH=5HD
HREIhBFHE

J—R - /)X—F 4 —D JAR 77 1)L%& Web 7O 7 NNTHATIEHEIL. £
D7 7A4IV%E JAR 77 AIVDEE) Web 7OV hDIAT T — -+ Tx)VY
— WA A= THZLE2BEDLET, ZHUL. JAR 7y (I EFRICHEHTS
BE D, REE TEHRS NIZBMEIERME—DHETH O, JlOHT—N—IzF7 7oA
THERICEEEMADLEND D EH A,

H—0 Web 7027 M THE JAR 77 A IVEMEHT 2ICIZ. LFORAT Yy 7%
FEITLET. JAR 77 AIVEEED Web 7027 NTHEHATZ2HEND 555
1Z. RRoODIZ, 56 XR=20 THED Web 7027 N TH—R - /)N\—F 1 — JAR|
[T 5720 DHERINDS HiE] [THAL TWAHE ATy TZ2FETL T I,
1. TZ74J) (File)l > T4 R—F (Import)l > T774)L - L RF A (File
System)] Z#RL. RN (Next)] 227U 7§ %, JAR 77AINA 2R
— RRIZEBHINARNWKDIZ, Zip Z74) (Zip file)] T3 774
JV - > RXT A (File system)] %&IRL T2,
2. TSE (Browse)l 27U w7 LT, JAR 771V T4 L7 M) —%KT,
3. TDOT 4 L7 kU —% [WebProject/WebContent/ WEB-INF/lib] 7 # )L —I21 >
R—=KT%, T T. WebProject 1& Web 7O 7 NDARITY,
4. TH#T (Finish)l 2271 w2795, JAR 77 1J)LZ. Java EJL K - )X ZITEM
INET, T2 A LRFITRHEREHIIMITILD D £H A,
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BHD Web 7OV FTY—F - XN—F 14— JAR 2fEHTS
DRSNS AHE
F—R - /)X\—F 1 —D JAR ZHEED Web YO/ NTHEHATIEHEIL. D7
71I)V%& (JAR 77 AINVDEF) T2 —TIF314 X -7 7Ur— 3> (EAR) 7O
P MIA PR —hTBIEEBEDLET, UL JAR T 7 A IV EFRICMH
AT 5580, 12EE TEZRINLBMERERME—DHFETH O, HlOT—N—IZF
TOA T EHGHRICEEEMADLEND D EH A,

SR JAR 7 7 A IVEBED Web 7O 7 NTHAT 21213, WFOAT Y 7%

EIFTLET., JAR 77 (I EH—~O Web 7O 7 N TUNMEAT 2N /R0N

e, fiotrsra oAry TEETLET,

1. TZ74J) (File)l > T4 >KR—F (Import)l > T77A4)L - L RFT A (File
System)] ZERL. RN (Next)l 271w 735, JAR 7 71IVDA 2R
— MEFIZEBH S NRWEDIZ, IZip Z74) (Zip file)] T3z 774
JV - > RXT A (File system)] %&IRL T 7230,

2. 88 (Browse)l] 27w Z7 LT, JAR 771+ T4 L7 M) —2&T,

3. JAR 77 1)V%&. Web 7OV FINADTWABIL Y —TIA4 X -7 TUr
—ay--7ayzy MNMIA R — KT %,

4. T#T (Finish)] 227w 7 3%, JAR 7 7-1)Vid. Java EJL R - XZICHE)
HINBIENET, T2 1 ARFICHERAT IIMICIZH D F8 A,

5. Rotv o2 aODATw 7E2ETLT, JAR & Web 7OV FOEI a—)b
KRERRICEINT 5,

588 JAR 7 7MWV ZEERTH=0DRKERE (FO—nNIb- EN
REXVOY—/N— "+ S5 R/IR)
JAR 7 71 )% WebSphere Application Server - Express DIERIZFR L /2 F £,
Java EJV R « XA EH—N—+ A 2 AF L ADT T A/NADEHKITEMT 2T EH
TEET, ZOHEERSE, 77U r—a  E2lHIIBHETER< /5720,
BEOHLEREA. HlOT—N—IZBHLEHEA. O —N—0D7 T A/NAZNHT
EHLABTNIRBRDER . o, VIX - Ty AV, TTIZZEDOH—N—0DY
FTANZIZADTWD (D, —=N—FZEMO T 7V r—= a ThEl) o
N=2a > DERKIBT T « Ty AINEFELTOWRNWI EBERLRTNIERD
FEh, 207 70—FZ2LELEEIE. UTOAT Yy TE2FETLET,
1. S8 JAR 77 ()%, JAR 77 AV ERBEETEHT 027 hO Java Bl
N/ VAV S i=)) IR
a. 7OV bEERLTEHEYVA - RY 2T Uw L, Ry TT v T« A
Za—n5 I7A/F 4 — (Properties)] %i&RT 5,
b. [Java EJVF - /XX (Java Build Path)] 227U v 7§ %,
547>V — (Libraries)] ¥ 77U v 795,
r44+88 JAR M3EN (Add External JARs)] =7 U w7 § %, JAR 771
WEBRIRL T, TE< (Open)l 227U w7 %,
e. TOKl 2710w rd 5,
2. S JAR 77 AV EY—)N— A 2 AF ZAD T FA/NAITEMT %,

o

&
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[ —/N—H§HL (Server Configuration)] Eax—ZBE, [H—/N—
(Server)] 7 4 I)V&¥—%IERT 5,

L 7Yz M TF IO SN TVEY—N— - { VAT AZEIRT D, 4

XUA Ry >TU7Uw LT TR (Open)l 27Uy 735,
/XA (Paths)l ¥ 7% 7 1) v 7§ 5%,

. ws.extdirs N 988 JAR D3EN (Add External JARs)] =7 U w7

%5, JAR 77 I)VERERL T, TH< (Open)l 27U w95,
ws.extdirs 177U —2 3> JAR 77 1IVICEHIN. 75 ZAINA
(CLASSPATH) 31 —/N— JAR 771 IVITHHINS Z LICTHEEL TLES
I/)o

LN — A AT AL, AHEZERET S,

REZ7OH N JAR ZFERALERIVFTOS IS M - ENRDRE(L

WebSphere Application Server - Express DFRIJZHBIEIL R « 74 —F v —Id, &
Mrz<)bF7ooz /7 b - EJVRTIE, EIVE - RT3 — D AZE NS 2006
HRHVET, INSOHBEI REFETLITIEN< DONOHERD D TN
Bz WEZ 7M. TOT4TBXYET VT4 7 -T2V b, V—A%
X JAR 74 —x v hOT7OYxl M2E), INSDOF T a JEIEEITEM
BDIBRLARMENHDET, INHSDF T3> EEINR - NT =X L ADK
BRI DWW TR L2 &R D £9.  WebSphere Developer Domain D &L

MOptimizing Multi-Project Builds in WebSphere Studio Application Developerl

(www.ibm.com/websphere/developer/library/techarticles/0204_searle/searle.html) % Z:Hd L
TS,

Ant ZERL/ZBEERBEINF

Ant % WebSphere Application Server - Express T L TEEE )L RE2HEMLT 5
TENTEET, UTOZLZHHLILEROEY > a  noR2&RPH 0 X

j‘o
Ant &3
Ant % WebSphere Application Server - Express DWW DIl THEITT 54

Ant % J2EE L A > b (EJB. WAR. EAR. 72&) OFEFHEI RTHHAT DS

Ant ZHH D WebSphere Application Server - Express EJV R « % A7 THLIRT %

WebSphere Developer Domain D FCF MUsing Ant with WebSphere Studio Application]|

(www.ibm.com/websphere/developer/library/techarticles/0203_searle/searle1.html) 7z Z:Hid
LTSN,

#oHm )R-ty hTw T (T4 T7FU—, JAR. @707  JAR. Ant EJLE) 57
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EF10E M —2a>nfl

ZDOETIL, VisualAge for Java 3L N WebSphere Studio "Classic” 75
WebSphere Application Server - Express IBM WebSphere Studio Site Developer ~\ O
RATL—2a > OFFHTEIDOIA T L —a O ERTLET,

* VisualAge for Java JSP/Servlet &> 7 )l (LeapYear)

* WebSphere Studio "Classic” Web 7 7' Ur—3 3 > « 42 7)b (YourCo)

VisualAge for Java JSP/Serviet 37 )l (LeapYear)
B9

ZHUZ. VisualAge for Java /N—37 3 > 4.0 IZfI/ED FindTheLeapYears & WD H >
TIVTY . FEMICDOWTIE, VisualAge for Java DA > T4 > « NIVT (T T
(Samples)] > [JSP/Serviet FFiRiE (JSP/Serviet Development
Environment)] ) 2SR L T</Z3 0,

RATV—2 3 O

PURDOFNEIZHES T, VisualAge for Java 75 IBM WebSphere Studio Site
Developer IZH > 7V EXA 7L —a>LETd, FAT Y FIZOWTIILRTHEL
<#HHLET,

1.

6.

[VisualAge for Java 225D Java 7 7 AN BXOT7OV I - UV —Z - 7 7|
HlEZ 7 ZR—F73 2]

(g L\ IBM WebSphere Studio Site Developer Web 7 02 7 k& 1ERk T 5]

Java 7y ()70 k- —Z 7 7A)L% IBM WebSphere Studiol
Site Developer 702 7 MNZA 2 h— KT 2|

[P—7LyheERLl. BEELLEY U —2 a2 2L T %)
[[BM WebSphere Studio Site Developer H—/\— - 702 =7 K &1EKT 5}
(XA L —=a sy 7V r—a a7 AT 5L

VisualAge for Java WSD 7 7 A IVDIH RAKR— b

o =

6.

© Copyright IBM Corp. 2000,

VisualAge for Java Z B <.

fIBM JSP Examples] 70>t/ h&#ERT %,

TP "NEAYIA RY Ty LT, TZTHRKR—bB (Export)l
Z®RIRT S, [F4L2& Y— (Directory)] 524 - Ry D EBIRLT. TR
~ (Next)] 27U w279 5%,
T7ANDIIAR=REDT 4 L7 M) —%EANT S,

lclass] Frv 7 « Ry AR RERT 2. ZNH5D7 71 IV,

WebSphere Application Server - Express T/ O ”7 hEHE)L RLTHSHIE

RLUETOT, TV AR— T 205EIHDEHEA.

ljaval w7 - Ry 7 AZERL T I (Details)] =27 v L,
LeapYear] 7 7 1)L DAZERNL T 0Kl 27U v 7T %,
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7.

8.

9.
10.

11.
12.

lresource] F= 77 - Ry 7 A% R L T M4l (Details)] 227U v 7 d
éo

[LeapYearinput.html] X\ TLeapYearResults.jspl Z#{RT 2, 215
2. 7«4 L2 U — IBM WebSphere Test
Environment¥hosts¥default_host¥default_app¥web¥JSP¥sample3 IZ A >
TWET,

oKl 227U v 273 %,

Y=—7 X DR (Create Manifest)] v 7 - iR 7 A% IR
D (NZTxAB - T AINVEERT 2HEIH D EHA),

M7 (Finish)] =271 v 7§ %,
VisualAge for Java ZF U %,

¥i#R IBM WebSphere Studio Site Developer Web 7O 1

b DYERL

1.
2.

6.

7.

IBM WebSphere Studio Site Developer ZHAE1T 5,

LeapYear EWDAFIOFH LW O 7 NEEKRTS (T774)L (File)l >
TIRIERL (New)l > T7OP o b

(Project)] > 'Web] > 'WebProject] ).

Dynamic 7O 14 b (J2EE Web project)] 7VEIIRETH 5 Z & 2R
LT, TRA (Next)l 221w 7¥ 5,

TETR/ERR (New)l %3#IRT 5,

(T —TS5A4X-T7FUV =3 - 702 1Y b4 (Enterprise
Application project name)] % LeapYearEAR IZZEH L T, [J2EE LAJL 1.2
(J2EE level 1.2)] 227U v 7§25, Web 7OPx” M, BFEOIL> Y —T
FAX -7 TV r—a (BEAR) 7O 7 MTAND T EMTEETN, Z
DHITIE. LeapYearEAR [T AIET,

a5+ Xb - Jl—b (Context root)] 7 ¢ —Jl RIiZ LeapYear &EANT

)

M4&7T (Finish)l 227 1) v 7§ 5%,

Java 77M)E7OP O - UY—=R-T774)LD IBM
WebSphere Studio Site Developer 7O 19 FADA 2 R—

b

DUTFDOAT Y TE2ETLT, Java V—A + 77 A )% LeapYear 7O/ K -V
— A T4 L7 R)—IZA >AR—FLET,

1.

2.

[Web] /N\—AXZ 5 (7T LeapYear ZJEFIL. [Javasourcel = L 7 b
U—%#IRT 2,

[774JL (File)l > T4 R—b (Import)l > 7 74)L - > RFT A (File
system)] ZERLT. TR (Next)] 227U v o 9%, 7y IVELT AR—
N7 L7 FNU—%2T759 LT TOKl] #27Uvrd %,
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3.

Java V—Z + 77 1)V DA% [Javasourcel 7+ L7 b —IiZA >R—hkL7J
WOT, A 2A—1F (Import)] ¥4 707 T, Tlexport] T4 L7 N —%)E
L. Teoml 751 L7 hU— (Java V—RA - 77 AV} 3 DA>TWS
YITTF4 L7 M=) OAZERRT 5,

&7 (Finish)] 227U v 27 9%, INT
LeapYear¥JavaSource¥com¥ibm¥ivj¥wte¥samples¥leapyear¥LeapYearXXXX.java 7 7
AIVDMERRINET ., Java 77 T Ald LeapYear/webContent/WEB-INF/classes 1
HEMICO > 1L I NE T,

UFDATY T2FEFTLT, UV—A+ 77 1)L% [WebContent] 71 L7 KV
— F® [LeapYear] 7OV MZA >HR—KT 5,

1.

2.

BfTD TWeb) /N—AXRZ T 47T, [LeapYear] YOI/ hEERL,
WebContent] 7 L 7 N —%&#IRT %,

[774) (File)l > T4 >R—bF (Import)] > 7 74) - > XF A (File
system)] Z3ERL T, RN (Next)] 227U v I d %, 7yAI)VELT AR—
NL7T4 L7 N)—=2T59X L, TVAR—hF T4 LT N)—%
lsample3] Y75 L7 NU—IZEBAL T, TOKl] 271U w735,

Y —2Z «77A)iZiF%& WebContent] = L 7 hU—IiZ1 >HR— T 57
DIZ, A >AR—F (Import)] ¥4 70T, jsp 771J)V& html 77 A )L
ADTW5% lsample3] 75 ¢ L7 N —2#RIRNT B,

M#&7T (Finish)l 2271 v 27 95%, 771)L/" WebContent] =1L 7 k1) —
W21 iR —hENET,

Y—TUVy bOEERLEBBELET TV IT—2a v DEE

1.

A

KiZ, =T L NEERT S, [LeapYear)] YO/ hEZEIRL T, Tz
webxml 7 71 )VETIET S ( lLeap
Year] > WebContent] > TWEB-INF] ). webxml 7 7 1)L ZBE X7,

R=VOFHEICH 2 TH—T Ly b (Serviets)] ¥ 7% v 7§ 5%,

MEM (Add)) 227U v 7T 5,

MY—7JL v b (Servlet)] 7F « RY DINBIRSIN TS Z E2HERT 5,
275 X TLeapYear] Z#EIRLT. TOKI] 27U v T 5,

TURL ¥ v E>% (URL Mapping)l > MNEHN (Add)l ZiE{R L T. LeapYear
EANT B,

EBHEERELT (T774)0 (File)l > Tweb.xml ORE (Save
web.xml)] ). webxml 7 71V ZFAL %,

V=7 TV —a UREENETFERINTNWSDT, YT Ur—a AR
A DENDH D XT,

1.

2 DOLT—MN [ A7 (Tasks)] Ea—ICEREINET, 1 DI
LeapYearInputhtml NOLZ—, 5 1 DId LeapYearResultsjsp ND LT —T
—a‘o

LeapYearResults.jsp 7 7 1 )L Z B <., /ISP/index.html % LeapYearInput.html (Z
BEEHZ D,

LeapYearInputhtml 7 7 1)L ZHi <,
/servlet/com.ibm.ivj.wte.samples.leapyear.LeapYear % LeapYear IZEZHIA 5,
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4, ZHZ{RE L T, LeapYearResultsjsp 7 71 JV'& LeapYearlnputhtml 7 7 1 )L %
L%,

5. AL TIT—MREAELBNELDITTSHEDIT,
JavaSource¥com¥ibm¥ivi¥wte¥samples¥leapyear 75 ¢ L7 N —IZH B
LeapYearjava 7 7 1 )L ZBA <,

6. 118 fTHIZHEIL . getRequestDispatcher % *“/JSP/Sample3/LeapYearResults.jsp” 7
5 "LeapYearResults.jsp" ICEHE T %,

7. BEERE LT, LeapYearjava ZF U %,

ZHT. B> 7I)iE IBM WebSphere Studio Site Developer ([CX 127 L —3 3 > &
NFE L7, dEIE. IBM WebSphere Studio Site Developer H—/N— « 7O 7
NZVERR L T, B> 7 )% WebSphere 7 A MREETT A M9 57211 TY,

IBM WebSphere Studio Site Developer ¥ —/\— - A< x4
N DYER

1. TZ74)V (File)] > TEi#RERX (New)l > 7O x4 b (Project)] > TH—
/N— (Server)] > T—/N— 7O x4 k (Server Project)] =7V v 7o
%, RN (Next)] 227U v 2rd%, [FOYx4H b4 (Project name)l 7 «
—)U RIZ newServer EANIL T, T (Finish)l 227U v 735, HEIIC

[ —/N— (Server)] /N—AXRT T4 TIZHOEDLD FT,

2. [newServer] Z4H~XTU X « Ry T/ U7 LT [#H# (New)l > T—/N—
&Y —/N—#8rk (Server and Server Configuration)] =7 U v 7§ %,

3. [H¥—/\—% (Server name)] 7 ¢ —JL RIiT WSTestEnv &AL, TH—N
— AR REB! (Server instance type)l 7« —J)L R T WebSphere
v4.0 TR MRIE (WebSphere V4.0 Test Environment)] Z#{RL T, &7
(Finish)] 2271 v 79 %,

KIZ, Y—=N—RERIZH LT EAR 7027 2R ETDIHNENHD FT,

1. I8 —)N—HkEp% (Server Configuration)] Ea1—7T, H—/N—IEHZEL T.
[WSTestEnv] Z71v 79 5%,

2. TNEALARTA - RY T Uy LT, TEH (Add)l > [LeapYearEAR]
0w T 5,

RALT V=23 FEHRD LeapYear 7TV —a> DT R

1. LeapYearInputhtml 7 7 )L Z#RT 5,

2. HTIML 77 MI)V&HERTA + RY 2T U I L, Ry T Ty T « AZa—n
5. Y —/N—T=x7T (Run on Server)] =71 v 7T 5%,

3. B—N—NIKENT 2 £ TRHET S, Ta>VY—Jl (Console)] X— ( [H—N
— (Servers)] Ea—® a2V —)L (Console)l ¥ 7%7Y w79 5) DEH
%, Te-business FIICT 74V bk « H—=N—DNFANTNET | EWnWHAvt—
INFIRINDETHITET,

4. TIUY =W 5, TBIGAE (Start Year)] 7« —J)V RIZ 2001 EAHL.
[R{T{&EE (Submit)] 27U w7 T 5,
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5. [a>>)—Jb (Console)] Ea—IT. LeapYear:init EWVWD A vt —TINKRE
Nb, DBIFED) XA NNFRINDETHHL., H—/)N— (Servers)] Ea1—
T TWSTestEnv] Z&RL T, fAivxTA Ry &7y, MELE
(Stop)l 2271 v T %,

f5]: WebSphere Studio "Classic” /A\—< 3> 4.0 Web 77V — 3>
(YourCo)(Windows)
58

Z DFITIL. WebSphere Studio "Classic” /N—<"3 > 4.0x ZfHAL7FIUI7a0 £
A,

INMSHEHAT2Y > 7IVE. YourCo B> 7 IV TCT, ZOH > TIICT AT
51213, AT - ANV TEBAEET ( IANILT (Help)l > T'WebSphere
Studio 4.0] > A% (How to)l > > 7ILDER (Work with the

samples)] > T#IZE (Overview)] ) ZOY > 7))V E0O—RT5i2iL, [lStudio ¥
v 7L EB< (Opening the Studio Samples)] (WebSphere Application Server
4.0 A ICREH SN TN B RIS T, YourCowar 20— RLXT,

AL —2a LY 7Ur—3 a3 IBM WebSphere Studio Site
Developer TFEfTL £974%. IBM WebSphere Studio Site Developer (21, HiKf
# T WebSphere Studio 707 =¥ aFIVBRERIZT RN A RROTRTD
Web R—IREHEREB KO RBKENHEIN TV SDITTIEH D £H A,

1R B ANIC

* YourCo ¥ > 7))V« 77 Ur—3 a A WebSphere Studio "Classic” 20— R X #1
TWb I EZHRT 5,

* WebSphere Application Server DI XTDA > AY > A%&EHKT S ( IBM
WebSphere Studio Site Developer & D#iy ZBi <72),

RATGV—2a>DRTY T

WebSphere Studio "Classic” 7% IBM WebSphere Studio Site Developer {24 > 7))l

EXATL—2a29212F UFORXTy TE2ETLTLEIN, EAT VT

DNWTIELIETH L <SHMAL X7,

1. (X7 a>)|WebSphere Studio "Classic” ZEIL. FH 1/ L — 3> - 7]
[F— 2 2 1ERT 2}

. Web #mkatih 17 7 1)V &R T B,

.M L= a2 WAR 77 A1) (WebPath &5 ZERT 5]

4. JIBM WebSphere Studio Site Developer ZME1L. WAR 7 7 1 )V &A1 > 1h— kT
5

. IBM WebSphere Studio Site Developer H—/N\— « 70 7 h &ZERKT 5|
RATV—=a ERT TV —a kBT ARNT B

[\

W

9]

=)}
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WebSphere Studio "Classic” /N\—2 3> 4.0 DIZEIE LUK
RATV—=ay AF—I0OERK
(FTrar) WL, A7 —2a  HOHLWAT—DZERLETHN, 20
i TIX. WebSphere Studio "Classic” ICHEINTWALET AL - AT —JZ2MHL X
T, TAK - ATF—YZEFEATNE. ATy T 8 TEZLDOY—TJL vk -XvE
DU EFHTRELRITNIERSBNWTFRHZE ZENTEET,

RATL—=2a HOHLWAT =P DIERAFIEICDNTIE.  TWebSphere Studio
"Classic” 7% IBM WebSphere Studio Site Developer "D 1 /L — 3 ] &%
L T<ZET N,

Web #8RECiEF7 7 1 IVDERK

1.

7oz s bk« 774) (project file)] Ea—7T. 7AYo b
(Project)] > Web #pkitik+7 7 1 JLDYERL (Create Web Configuration
Descriptor File)] #7 Uy 27 LT, T 74V MED
WEB-INF¥Tocalhost web.xml Z5ZiF A5,

W2 FTRTDY—T L w kb (xxxxBean EWVWDLFTLSNDTRTDOT v 1)) %
ERT 5,

3. ZOYAI)IC, AT - T4 T T ) —fiR T (TLD) 7 7 1 I)VIH 0 £H/ A,

4.

TERX (Create)] 227U w735,

RAV—=3> - 774 IVDERK

1.

7oy Z bk« 774)b (project file)] Y2 —"T. H—/N— localhost % #ER
L. I'Z0/85 4 — (Properties)] > 2B (Publishing)l > I'WebApp Web
/SR (WebApp Web Path)] 2271 v 27 LT, Web XA (A>TFAL - )b—
) “newStudioSample” & AJ1 9% (Web /NADREIL. mA&HI7R IBM
WebSphere Studio Site Developer &/ TIIHERY 7O —F L L THRINSFTET
EDB

7oz b« 771)b (project file)] Ea—7T. 7O xzo b
(Project)] > R4 L—>3> - 774 I)LDOERK (Create Migration file)] %
EIRT 5,

3. ¥—/N—& L T localhost WEN SN TS EZMERT S,

8.
9.

Web HipkidiR 7 7 1)L & LT localhost_ web.xml 7VEIREINTWS Z &2
WwT D,
OKl] 27 Uv 735,

T4V D JAR 7 7 A I3 X:¥Studio40¥projects¥YourCo¥localhost.jar (Z Z
T. X & WebSphere Studio "Classic” 1 > A h—JL« T4 L7 FJ—),

MRE (Save)l 27U v /T 5,
WebSphere Studio "Classic” ZP U %,
localhost.jar file % localhost.war ([ZFRITZAE T 5,

IBM WebSphere Studio Site Developer DiiEi& WAR 774
oA vkR—Fk

1.

IBM WebSphere Studio Site Developer ZIA#1d %,
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N

[Z774J (File)] > T4 >R— bk (Import)] > TWAR 774l (WAR
file)l > 'R~ (Next)] 227U w o9 5%,

FE: JAR 771U WAR 77 M) - F T a & 2RHLTA R—b LA
U, ELLEEL £8 A,

3. TWAR 774/l (WAR File)] 7 —)L RIZ localhost.war D/SZA% AT 5
. T8’ (Browse)l #7277 L THET S,

4. Tweb 7OPx & b (Web Project)] 7 ¢ —J)L RT T#RIEK (New)l %iEiR
L T. newStudioSample &EAH1T 3,

5. TEAR O2 x4 % (EAR project name)l 7 1 —)L R T T#RIERK
(New)] ZEIRL T. newStudioSampleEAR & AN1T 5,

6. [#87T (Finish)] #7271 w 73 %, IBM WebSphere Studio Site Developer 7%
localhost.war % f#H 9™ 5,

7. ZBOKRBROZISCA 2 R—b « T 7 A IVOREMN [ A7 (Task)] Ea—IC
ZREI N5,

a. com.ibm.db requires databeans.jar,

b. com.ibm.webtools.runtime requires webtlsrn.jar,

c. com.ibm.ejs.ns.jndi requires ns.jar,

d. com.ibm.webshpere.advanced.cm.factory requires cm.jar,

e. com.ibm.ejs.models.base.extensions.webappext.ServietExtensions requires
ws-base-extensions.jar

INZBIET 21T, Web 70227 FD Java EJV R - NZZEZEE LT HUL

B0 FER A

a. 7Oz hNehRIA Ry Ty LT, 7ANT4—
(Properties)] > Java EJL K - /XX (Java Build Path)l =7 1) v 7§
60

b. 54751 — (Libraries)] ¥ 7% 27U v 2o d%, [4E JAR DiEN
(Add External JARs)| Z7YU v 7§ 5%,

c. 74 L7 N — Mylnstall¥runtimes¥aes_v4¥lib /5. databeans.jar,
webtlsrn.jar, ns.jar, cm.jar. 3L ws-base-extensions.jar O#% JAR 7
7AINEA R — T 5,

d. RFGROEEDN 24 HDN, PIIAE,

8. [InewStudioSamplel YO - ”/ h&HX T A - RyY > THUw LT, IF

Oz FOBEJLER (Rebuild Project)] =71 v 7§ 5%,

ZHT, B> 7))V IBM WebSphere Studio Site Developer ([ZX1 27 L —3 3 > &
NELZ., dEIE. IBM WebSphere Studio Site Developer —/N— + 7O 7
NZE{ERR L T, ¥ > 7)L% WebSphere 7 A MRETT A NI B3 TY,

IBM WebSphere Studio Site Developer ¥ —/\— - 7O x4
;s DYERR

1. 5 —/N— (Server)] /S—AXRZ T4 TIZHDEHZ 5,

2. TZ74) (File)l > TH#RERK (New)l > IO 1o b (Project)] > TH—
/N— (Server)] > [Y—/N— - 7O 1o b (Server Project)] #7271 v
%, TR~ (Next)] 227U v 2rd%, 7FOYx4H b4 (Project name)l 7 «
—J)V RIZ newServer EANIL T, T#T (Finish)l 227U v -9 5%,
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3. [J+ES—%— (Navigator)] Ea2—T. newServer Z/ XX « IRy > TH/ Y
w27 L. [## (New)l > T —/N—<&H—/N—#8Rk (Server and Server
Configuration)] Z7 Y v 793 2%,

4. TH—/N—2% (Server name)] 7 ¢ —JL RIZ WSTestEnv E AL, TH—N
— A2 RH > RB (Server instance type)l 7 1+ —JI R T 'WebSphere
V4.0] > [ X FRIE (Test Environment)] Z#{R9 %, [#&T (Finish)] %
70w 79 %,

KIZ, B—=N—HERICH LT EAR 7O 7 h2IEETH2HENH D FT,

1. T —/)N—HkEpk (Server Configuration)] £ —7T, [HY—/\— (Server)] >
[WSTestEnv] =7 1) v 79 5%,

2. TNELARTA - RF T w2 LT, [EM (Add)] >
lnewStudioSampleEAR] %7 U v 7§ %,

E: (7T a ) TnewStudioSample)] 7O/ NEHAIYTA - Ry > TO U WY
LT I'70O/85 4 — (Properties)] > 'Y —/N—F&%E (Server Preference)l >
[RDOY—N—TEICRITLUET: (Always run on the following server)]
Z#IRL . TWSTestEnv] Z#R L. [EA (Apply)l > TOKl 227U v ¢
% (ZOFIEZ. iz —N—0H 2585 DAHNBETT),

RAT V=3 iEHD YourCo 77U —a>DFR b

1. TYourColntro.htmll 7 7 1)V Z&ERT 2D, ZDT 7 1)LIiE. newStudioSample
7oy NNDT 4 L2 ~1J— WebContent¥StudioSamples ([ZA > TWET,

2. YourColntro.html 45X T Z - RY > TH/UY I L, Ry TT7 T« AZa—
n5, [H—/N—T=xFT (Run on Server)] =717 LT, [WSTestEnv]
ZERT 5,

3. Y—N—NhET 5 ETHEET S, Ta>Y—JL (Console)] X— ( [H—N
— (Servers)] Ea—® a>Y—)b (Console)l % T7%&71vwrd5) DEH
Z. Te-business RAICT 7 A4 b - B—N=—DRHNTWET] NS Avt—
UIMERINDETRITET.

4. ZDY T )% F/Z WebSphere Studio "Classic” THEIT L7z I ENBWEHEIL.

[F—4& X—X#ERL (Database Configuration)] 27 w7 L TTF—F X—2
TR T BTN D D,

5. 79U =0WEs, A7 0¥ LT, TZOYTIVERTT (Run
This Sample)] Zz27 U v 79 5%,

6. 77— I x)VhL (Welcome)] R—INERINDETHEEL .

[Employee Center] #2717 § %,

F ZOT7 U= a ENOTETLEEEITE. Ta>y—)L
(Console)| N—IZRDLT—INFK/RIINE T, DataSource not found.
Try to construct a new datasource name: jdbc/yourco DataSource not
found. Try to construct a new datasource name: jdbc/studio. 235D
Io—3IHCHRITYT, INSOEHITEHRL THENERA,

7. T Ls, 7998 —] w02 Ry& [Web Browser] Ea—%FHUC., Y
—/N— - a2 kA=)l - /X3RJL (Server Control Panel)] T. [WSTestEnv]
EHERXTA - RY Ty LT ELE (Stop)l 227U v 7T 5%,
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8. (47> a>) IBM WebSphere Studio Site Developer ZFHU %,
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£ 1 & 2OMhROEH

XRATL—2a BRUEZOMD Ny 7 IZET 2 & OE®RD.
[www.ibm.com/websphere/developer/zones/studio/transition.html| 705 AT TE £,

WebSphere Application Server - Express Z |9 % & SITHIL D —RBEHRICTDONT

12, LFOBERBINY Web XR—PZZIL T ZI W,

s JSR-000053 Java Serviet 2.3 HI N JavaServer Page 1.2 Dftfk:
|java.sun.com/aboutJava/communityprocess/first/jsr053/index.html|

e IBM WebSphere Application Server /N\—3" 3 > 4 InfoCenter:
|www.ibm.com/software/webservers/appserv/doc/v40/aes/infocenter/index.htm1|

* WebSphere Version 4 Application Development Handbook:
[www.redbooks.ibm.com/pubs/pdfs/redbooks/sg246134.pdf|

* Programming J2EE APIls with WebSphere Advanced:
[www.redbooks.ibm.com/pubs/pdfs/redbooks/sg246124.pdf]

* WebSphere Application Server Version 3.5 to 4.x - Migration Hints & Tips:
[www7b.software.ibm.com/wsdd/library/techarticles/0208_wright/wright. html|

* WebSphere Studio Application Developer Service Portal:

[www.ibm.com/software/ad/studioappdev/support/

e WebSphere Studio Application Developer FAQ Frequently Asked Questions:
[www.ibm.com/support/search.wss2rs=457&tc=SSBRLP&dc=D800)|

* WebSphere Application Server Service Portal:

[www.ibm.com/software/software/webservers/appserv/support.html|

* WebSphere Application Server FAQ Frequently Asked Questions:
[www.ibm.com/support/search.wss ?rs=180&tc=SSEQTP&dc=D800)|

ZTOM, KOXIBERBBEITRD KT,

+ WebSphere Studio Application Developer T Ant O HICET 2 &R J2EE 7
O2x7 b« EJVRIZV AR—FEF0):
[www.ibm.com/websphere/developer/library/techarticles/0203_searle/searle 1.html|

« WebSphere Studio Application Developer (23517 2 &M/ E)L R O LI BEd %
R
|www.ibm.com/websphere/developer/library/techarticles/0204_searle/ searle.html|

« WebSphere Studio Application Developer ({2313 % I2EE 7 F A - O— RIZEHT 5
HEF (2EE £V 2 — I BXOY T A/
|www.ibm.com/websphere/developer/library/techarticle s/011 2_deboer/deboer.htm]|

e WebSphere Studio Application Developer {28575 J2EE I—7 14 UF 4 — JAR
DOBIFICET &R J2EE T 2 —)LIZBIT S Java JAR):
|www.ibm.com/websphere/developer/library/techarticle s/0112_deboer/deboer2 .htm]l

» WebSphere Studio Application Developer {28152 F— L4 « Hih— MBI 2 &R

www.ibm.com/websphere/developer/library/techarticles/ OlOS_karasiuk/I

01 O8_karasiuk.html|
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http://www.ibm.com/websphere/developer/library/techarticles/0108_karasiuk/0108_karasiuk.html

* VisualAge for Java 75 WebSphere Studio Application Developer N\ Enterprise
Access Builder IR —3%> hDX AT L — a3 BT 2 &R
[www.ibm.com/websphere/developer/techjournal/0201_minocha/minocha.html|

* Session Facade Zfif L7z CMP EDXFED EIB 7 /U —3 a »EHIBT 5
s
|Www.ibm.com/ websphere/developer/library/techarticles/ 0106_brown/ sessionfacades.htm]l

* WebSphere Application Server fizEHIZEET 5 &k
|WWW.ibm.com/software/webservers/appserv/ws_bestpractices.pdﬂ

* WebSphere i REHF — 2B % &R
|Www.ibm.com/websphere/developer/zones/bp/|

* WebSphere Developer Domain AT 22 Web X—2:
[www.ibm.com/websphere/developer]

» WebSphere Developer Domain D77~ =71 )L it
[www.ibm.com/websphere/developer/techjournal/|

* WebSphere Studio 7 7 2 J—, 3BLU WebSphere Studio Application Developer
DT 4 —F v — EFMGIEITET S 16
[www.ibm.com/websphere/developer/zones/studio/transition.html|

« IBM WebSphere Studio 7 7 X U —BiFEY — )L &L EH:
[www.ibm.com/websphere/developer/library/techarticles/0108_studio/studio_beta.html]

« AN Application Developer =1 — A7 )L —7"
[news://news.software.ibm.com/ibm.software.websphere.studio.application-site-developei]

o T —2 R>F (Bclipse) Za— AT I —7"
[news://news.software.ibm.com/ibm.software.websphere.studio.workbench|

+ 4L WebSphere Application Server =1 — A7 )L —7"
[news://news.software.ibm.com/ibm.software.websphere.application-server]

* WebSphere Studio Application Developer 75 WebSphere Application Server ~\ 0
REE 77U r—a o7 7oAz &8
[www software.ibm.com/vad.nsf/Data/Document3584|

* Application Developer Software fERREH (V) —A « O— FEH) X245 —:
[www.ibm.com/software/ad/studioappdev/partners/scm.html|

o 77U — arDFEZEMALBFEY — IV S Application Developer ~DX 1 7 L
—>a .
[www.ibm.com/websphere/developer/zones/studio/migration.html|

* VisualCafé WebLogic 7 7'J % —3 3 > @ Application Developer ~D< - 2/ L —
3 > (WebLogic T 7))
|www.ibm.com/web sphere/developer/library/techarticles/0209_searle/searle .htm1|

* Eclipse.org:

» WebSphere Developer Domain 75271 >« &> ks F)b:
|www.ibm.com/websphere/developer/downloads/plugin/|

* Eclipse 7—27X>F « 75774 > (Eclipse.org D/N—" TII72WN):
|www.eclipse-workbench.com/jsp/plugins.jsp|

* Eclipse 7—2X>F « 7574 > (Eclipse.org D/N—" TII7211):
[www .eclipse-plugins.2y.net/eclipse/plugins.jsp)
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